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Sobre Barcelona Activa

Barcelona Activa és I'agéncia de desenvolupament
economic local de Barcelona. Fundada el 1987, és
una societat mercantil publica integrada a I'area
d’Economia i Promocié Economica de I'Ajuntament de

Missio
Promoure I'ocupacié de qualitat, 'esperit emprenedor, la

competitivitat empresarial i la diversificacié del teixit productiu, per
assolir un model econdmic sostenible, inclusiu i just.

Barcelona.
Visio
0% 55.000 Fer de Barcelona una ciutat de referéncia per treballar, emprendre i
fm fm persones ateses viure amb valors socials i ambientals.
Valors
H 7000 Ens mou I'esperit de servei public i I'ética professional i personal, aixi
E empreses ateses com la igualtat d’oportunitats i el progrés social. Treballem en

cooperacid dins I'organitzacié i amb altres per a una economia social i
sostenible al servei de les persones.

Segueix-nos a:
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fem?

Acompanyem la ciutadania
durant tot el procés de recerca
de feina.

barcelonactiva.cat/treball

Ajudem les empreses i
organitzacions a créixer,
connectar-se amb I'ecosistema
i fer-se més competitives.

barcelonactiva.cat/empreses

Donem suport a les persones
emprenedores per convertir la seva
idea de negoci en una empresa
viable.

barcelonactiva.cat/emprenedoria

Oferim formacio a les persones que
cerquen feina, emprenedores i
professionals.

barcelonactiva.cat/formacio




rxa d’equipaments
Barcelona Activa

Seu Central

Seu Central de Barcelona
Activa.

Porta22

2.000 m2 per a l'ocupacid i la
carrera professional.

El Convent
L’equipament referent en

ocupacio per a joves, a Ciutat
Vella.

InnoBA

Centre per a la innovaci6

socioeconOmica de Barcelona.

Centre per a la Iniciativa

Emprenedora Glories

L’equipament dels emprenedors i les
emprenedores de la ciutat.

Incubadora Glories

L’equipament de les
empreses innovadores de
nova creacio.

Oficina d’Atencio a les

Empreses

L’espai de referéncia per a les empreses
i pimes de Barcelona.

Cibernarium 22@

Centre de capacitacio
tecnologica per a professionals
i empreses.

Cibernarium

Nou Barris

Centre de formacio digital d’iniciacio
ubicat al Parc Tecnologic.

Parc Tecnologic

Cluster d’innovaci6 al nord de la
ciutat.

LIDERA

Espai per a dones professionals,
directives i emprenedores.

Espais Activa a la ciutat
* Nou Barris Activa

» Sant Andreu Activa

» Sants-Montjuic Activa



Barcelona Activa esta present
a meés de 50 punts de la ciutat
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ERGUONOMIA




L1, ERGONOMIA

>

vV v v v VvV

Monitor: A I'altura dels ulls

Teclat i ratoli: Ben alineats amb el cos
Bracos i cames: Formar angle de 90°
ll-luminacid: Sense contrastos bruscos
Vista: Fer descansos frequents

Estiraments: Suau moviment cada hora




Cl. Descansar |a vista

Distancia: Pantalla entre 50-70 cm
Mida de lletra: Ajustar per llegir bé
Llum natural: Posicio lateral o frontal
Parpelleig: Hidratar els ulls sovint

Pausa visual: Mirar lluny cada 20 min

vV v v v v Vv

Brillantor: Ajust segons 'ambient




[l. Postura saludable

Esquena: Recolzada totalment a la cadira
Coll: Sense inclinacid excesiva
Avantbracos: Paral-lels al terra

Cames: Genolls a 90 graus

Pausar-se: Mou-te cada 30 minuts

vV v v v v Vv

Cadira: Amb suport lumbar ajustable
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LAIDENTITAT DIGITAL
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Cl. Proteqir la nostra identitat digital

Contrasenyes: Minim 8 caracters segurs
Canvis periodics: Sobretot si hi ha risc

No repetir: Una mateixa contrasenya
Publicacions: Evita dades personals visibles
Privacitat: Controla qui veu el teu perfil
Alertes: Avis d’accessos sospitosos

Wi-Fi publigues: No entrar-hi comptes personals

vV v v v v v v %

VPN: Protegeix |la teva connexio.
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Cl. Certiticats digitals

» Ens identifica

» Permet demostrar la nostra identitat en entorns
digitals segurs.

» Permet la signatura electronica

» Signa documents amb validesa legal des de

I'ordinador o mobil.. nostra identitat en en-
torns digitals segurs.

Permet demostrar la




Cl. Mesures de sequretat

» Copia de seguretat

» Permet recuperar dades importants en cas de perdua
O avaria.

» Contrasenya

» Ha de ser robusta, combinant lletres, nUmeros i
simbols.

» Revocar

» Cal anul-lar el certificat si sospitem d’un Us no D
autoritzat :

—~
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Cl. Caracteristiques del comerg electranic

Y

» Obert 24 hores

» Permet comprar en qualsevol moment, sense horaris.

» Accessible per a tothom
» Només cal tenir connexio a internet.
» Accés a gran varietat de béns i serveis
» Hiha opcions locals i internacionals.
» Despeses d’enviament

» Algunes plataformes ofereixen enviament gratuit o
amb promocions.



Cl. Tipus d'e-commerce

» B2C (Business to Consumer)
» Venda directa a consumidors: Amazon, Zara, Decathlon
» D2C (Direct to Consumer)
» Fabricant ven sense intermediaris: Hawkers, Cooperativa
» B2B (Business to Business)
» Operacions comercials entre empreses: Alibaba, Majoristes
» B2E (Business to Employee)
» Productes o serveis per a empleats: Web descomptes exclusius
» C2B (Consumer to Business)
» client ofereix serveis a empreses: Influencer promociona marca
C2C (Consumer to Consumer)

» Intercanvi entre consumidors: Wallapop, eBay, Vinted.




Cl. Elements de sequretat

» Cadenat
» Indica que la connexid és segura.
» https
» Protocol per a transmissions xifrades.
» Cercar referencies
» Revisar opinions i valoracions abans de comprar.
» Tipus de connexio

» Millor evitar Wi-Fi publica en compres.




Cl. Metodes de pagament

» Transferencia bancaria

» Pot tardar unes hores o dies.
» Targeta de crédit/debit

» Rapida i ampliament acceptada.
» Contrareemborsament

» Es paga quan arriba el producte.

» Paypal

» Afegeix seguretat i no comparteix dades bancaries.




Cl. Passos per fer una compra en linia

1. Accedir al lloc web

2. Comprovar la seguretat del web
3. Registrar-nos/autenticar-nos

4. Cercar i seleccionar els productes
5. Revisar el carro

6. Acceptar el pagament




Cl. Passos per fer una transferéncia bancaria

1. Anar al web del banc

2. Iniciar sessio

3. Triar I'opcio transferencia
4. Introduir les dades

5. Comprovar les dades

6. Acceptar

7. Fer servir les coordenades de seguretat.




COPYRIGHT COPYLEFT

1. BOLTURA! PARTICIPACI | CIVISME DIGITAL
DRETS D'US
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Cl. Continguts de la Xarxa

» Drets d’autor

» Es necessita permis per copiar o distribuir.

» Drets d’explotacio DRETS D'’AUTOR DRETS D'EXPLOTACIO

» Permeten comercialitzar, reproduir i distribuir una
obra.

-

_ COMERCAHZZAR, =
REPROBUIR DISTRIBIUI

.




Gl. Llicencies

» Copyright

» Lautor manté tots els drets. Cal permis per fer servir

I'obra. Copyright

» Copyleft

» Es pot copiar i modificar, pero mantenint la mateixa
llicencia.

» Creative Commons Copyleft

» Llicencies flexibles: permeten decidir si es pot
modificar, vendre o compartir.

Creative
Commons




Cl. Copyright

» Exclusivitat

» Lautor té el dret exclusiu d’us de I'obra.

» Permis obligatori

» Cal autoritzacio per fer-ne Us.

» Proteccid Copyright

» Controla com es fa servir la creacio.




Cl. Copyleft

» Copiar
» Es pot reproduir l'obra lliurement.
» Modificar

» Permet canvis si es manté la llicéncia.

Copyleft
» Redistribuir opyle

» Es pot compartir 'obra original o modificada.
» Diferencia amb copyright

» Amb copyleft no cal permis per fer servir I'obra si es
respecta la llicencia.




Cl. Creative Commaons

O
S
©
©

Reconeixement (BY)

No comercial (NC)

Sense obra derivada (ND)

Compartir igual (SA)

)

Creative
Commons




Ll. Reconeixement (BY)

» Cal esmentar l'autor
» Es pot compartir i modificar 'obra.

» Exemple: un blog de receptes pot utilitzar fotos
d’una fotografa acreditada.




Ll. Reconeixement - no comercial (RBY-NE)

» No es pot fer us comercial
» Només per projectes personals o educatius.

» Exemple: una escola de ioga utilitza una musica
d’ambient per videos interns.

BY




Cl. Reconeixement - no comercial - compartir igual (BY-NC-3A

» No comercial i amb la mateixa llicéncia

» Les modificacions han de mantenir la llicéncia
original.

» Exemple: un taller d’artesania fa videos amb grafics
reutilitzats d’'un dissenyador freelance.

BY




Cl. Reconeixement - no comercial - sense obra derivada (BY-N

» No es pot modificar ni vendre
» Només es pot compartir tal com és.

» Exemple: una botiga de productes ecologics
comparteix un poster educatiu tal com I’ha trobat.

OISO




Cl. Reconeixement - compartir igual (BY-SA)

» Permet Us comercial

» Lobrailes modificacions han de compartir-se amb
la mateixa llicencia.

» Exemple: una startup de comunicacié utilitza
infografies modificades en les seves xarxes socials.

SA




[l. Reconeixement - sense obra derivada (BY-ND)

» Es pot usar pero no modificar
» Cal conservar l'obra original.

» Exemple: una llibreria comparteix una entrevista en
video sense editar-la.

ND




Cl. Comparacid general de llicencies

Copyright: control total per part de I'autor.
Copyleft: llibertat d’us, amb condicions.

Creative Commons: termes flexibles i adaptats.

vV v v VvV

Exemple: una cooperativa social tria una llicencia CC
per distribuir els seus materials didactics.




PERSONAL
DATA
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Cl. Dades de caracter personal

» Persona fisica

» Informacio vinculada a una persona real.
» Identificada

» Nom, DNI, correu electronic.
» Identificable

» IP, ubicacio o dades que poden associar-se a una
persona.




Ll Drets

» Accés

» Rectificacid

» Cancel-lacié DereChOS ARCO \

A P

Acceso Rectificacion Cancelacion
\ V'S N




Ll. Proteccit de dades

» Propietat de les dades

» Cada persona és la propietaria de la seva informacid.
» Us de lainformacié

» Només es pot usar per a la finalitat acordada.
» Proteccio i privacitat

» Cal aplicar mesures com xifrat i contrasenyes segures.




? B2

CYBERBULLYING (™).

PHISHING Taen
GROOMING

CI. CULTURA, PARTICIPACIO | CIVISME DIGITAL

Lo PERILLS ALES RARKES



Gl. Phishing

» Suplantacio d'identitat
» Correus o webs falses imiten serveis oficials.
» Dades

» Lobjectiu és robar informacié personal o bancaria.




Gl. Ciberbullying

» Delicte

» Actes repetits de violencia psicologica en linia.
» Amenaces i humiliacions
» Comentaris ofensius, imatges o rumors difosos.

» Anonimat

» Sovint els agressors actuen sense identificar-se.




Gl. Sexting

» Continguts erotics
» Imatges o videos intims compartits digitalment.
» Videos

» Poden ser reenviats sense consentiment i perdre’s el
control.




L. Sextorsid

» Xantatge

» Amenaces amb difondre contingut intim si no es
compleixen demandes.

» Imatges
» S'utilitzen per pressionar la victima.
» Puntual o continuada

» Pot ser un fet aillat o repetit en el temps.




Cl. Grooming

» Ciberseduccio
» Adults es fan passar per joves per enganyar.
» Menors

» Les victimes solen ser nens o adolescents
vulnerables.

» Favors sexuals

» Busquen obtenir imatges intimes o trobades
presencials.
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(2. Maquinari (hardware)

» Placa base

» Connecta i coordina tots els components.

» Processador (CPU)

» Executa instruccions i processa dades.
» Memoria RAM

» Desa informacié temporal per a I’'ds immediat.

» Disc dur (HDD/SSD)

» Emmagatzema les dades de manera permanent.

Conesctor de alimentacion. Puerto SATA
Memeria EAM
)
=]
il A
BIOS | & \
- ’ r'
\ Ao e K =) :
# ' 1 .’r‘
e
. Wicroprocesador Conectores de audic
Puertes da

entrada v salida

Chipset




2. Funcionament de |'ordinadar

» Execucid d’instruccions

» El processador llegeix la informacié de la RAM.
» Interaccio de components

» Treballen junts per processar i mostrar dades.
» Evolucio tecnologica

» Meés rapidesa, eficiencia i capacitat cada any.

Se procesa
la informacion

Se |lee el disco duro Se almacena en la ram




(2. Memoria RAM

Es molt rapida.

Es volatil: perd les dades quan s'apaga I'equip.

Es forca cara.

S'utilitza per executar programes i processos actius.

Té una capacitat limitada respecte al disc dur.

vV v v v v Vv

Com més RAM, millor rendiment en multitasca.




(2. Altres components

» Targeta grafica

» Processa i mostra imatges i videos.
» Targeta de so

» Gestiona l'audio d’entrada i sortida.
» Targeta de xarxa

» Permet la connexid a internet i altres dispositius.




CZ. Instal-lacia de maguinari

» Plug & Play

» Detecta el maquinari automaticament sense
configurar res.

» Taulell de control

» Permet instal-lar dispositius no reconeguts pel
sistema.
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(2. 80 aplicacions

» Sistema operatiu (SO)
» Controla el maquinarii dona accés a 'usuari.
» Exemples: Windows, macOS, Linux.

» Aplicacions

» SOn programes per fer tasques especifiques.

» Exemples: Word, Photoshop, navegador web.

Sistema operatiu (SO)

ij déna acces a l'usuari

Controla el maguinari

Exemples: Windows, mcQS. &
@

’
1 | &
L1 :

Aplications

naveagor web

Son programes per fer tasges
sspeciffices.

Exemples: Word, Photoshop, naveragor web.




CZ. El programari

» Aplicacions/Software
» Permeten fer tasques concretes com escriure o Apl]caC]OnS/SOftware

retocar imatges.

» Sistema Operatiu/Software

» Coordina els recursos del maquinari i executa Sistema Operatiu/Software

aplicacions.

» Maquinari/Hardware

Maquinari/Hardware

» SOn els components fisics que funcionen gracies al
programari.




(2. Tasques que podem fer amb el 80

» Modificar la resolucio de pantalla
» Ajustar la qualitat i mida segons la pantalla.
» Establir un protector de pantalla

» Prevé el deteriorament de la pantalla per imatges
estatiques.

» Eliminar aplicacions o components
» Allibera espai i millora el rendiment.
» Establir una contrasenya

» Protegeix I'accés al dispositiu amb seguretat basica.




(2. Configuracia del SO

» Barra de tasques

» Accés rapid a programes i notificacions.
» Tipusimida de font

» Millora la llegibilitat dels textos.
» Colorimidad’icones

» Personalitza I'aspecte i I'accessibilitat.




(2. Tasques que podem fer amb aplicacions

» Documents de text

» Crear i editar textos (ex. Word).

» Presentacions

» Fer diapositives visuals (ex. PowerPoint).
» Edicio d’imatges
» Retocar fotos i grafics (ex. Photoshop).

» Gestid de dades

» Organitzar informacio (ex. Excel, Access).

» Calculs i estadistiques

» Analitzar dades (ex. SPSS, Google Sheets).




(2. Preguntes

» Per a que serveix el protector de pantalla?
» Evita la degradacio per imatges fixes.

» | la contrasenya per entrar a I'equip?
» Impedeix accessos no autoritzats.

» Es pot establir contrasenya al protector?

» Si, des de la configuracio del sistema.




7. lcones

» Queée son?

» Representacions visuals de programes, funcions o
arxius.

» Per aque serveixen?
» Faciliten 'accés rapid i intuitiu.
» Exemples:

» El simbol de Firefox representa un navegador;
el de Word, un processador de textos.




(2. Descarrega de programari

» Llocs segurs
» Botigues oficials com Play Store o Microsoft Store.
» Evitar webs sospitoses
» Pot contenir malware o anuncis enganyosos.
» Referencies
» Llegir opinions i valoracions d’usuaris.
» Requeriments

» Comprovar compatibilitat amb el sistema i maquinari.




(2. Instal-lacid de programari

» Compatibilitat del sistema
» Cal verificar que el sistema operatiu és compatible.
» Capacitat d’execucio

» Processador i targeta grafica han de complir els
requisits minims.

» Espailliure
» Cal suficient espai al disc dur.
» Condicions d’Us

» S’han de llegir i acceptar abans d’instal-lar.




(2. Instal-lar aplicacia a I'smartphone

» Botiga oficial
» Google Play Store o App Store.
» Aplicacions fiables

» Buscar bones puntuacions i ressenyes.

# Available on the

L App Store

GET IT ON

. GO 0 g |e Play
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(2. Copies de sequretat

COPIA TOTAL (COMPLETA)

Fa una copia sencera de tots els expedients cada vegada. COPIA TOTAL (COMPLETA

» Sempre copia tot el contingut, hagi canviat o no.

Imagina una estanteria llena
, .. , L . de expedientes. I I I I I I I
» Restaurar és molt facil: només cal I'tltima copia. _ olotalalaliclc
Una copia total es como hacer

una foto de toda la estanteria
cada vez. \!
. . . . ) .
Exemple: Diumenge i dimecres es copia tota l'estanteria s .
o . » Miércoles: se vuelve a copiar
sencera; si dijous es perd tot, es recupera la copia de todo entero.
O|lojojojojo|o

dimecres.

» Ocupa més espai i triga més temps.

» Sistema senzill i fiable. . Domingo: se copia toda
la estanteria.




(2. Copies de sequretat

COPIA DIFERENCIAL

Copia només els expedients que han canviat des de I'Ultima
copia total.

» Sempre “mira” la copia total inicial.
» Cada dia pot anar acumulant més canvis.

» Restauracio rapida: total + ultima diferencial.

» Més rapida que la total, més pesada que la incremental.

Exemple: Diumenge total; dilluns es copia un expedient
canviat; dimarts es copien tots els canvis acumulats des de
diumenge.

COPIA DIFERENCIAL

Se copian los expedientes que han cambiado desde
la Ultima copia total.

Para recuperar: copia total + ultima copia diferencial.

Domingo
( ) Lunes Martes

+




(2. Copies de sequretat

COPIA INCREMENTAL

Copia només els expedients que han canviat des de I'Gltima
copia (del dia anterior).

COPIA INCREMENTAL

SUstsh
o) e o)

Exemple: Diumenge total; dilluns un canvi; dimarts un altre; Domingo Lunes Martes Miercoles
dimecres un altre. Cada dia només es copia el canvi del dia.

» Copia molt lleugera i molt rapida.
» Necessita totes les copies incrementals per restaurar.

» Molt eficient en espai.

» Ideal per canvis diaris petits.




(2. Copies de sequretat

COPIA EN MIRALL (MIRRORING)

Manté dues estanteries identiques: tot el que passa a una es
reflecteix a l'altra.

COPIA EN MIRALL

» Actualitzacié en temps real.

» No cal restaurar: el mirall ja té tot igual.

» Sis’esborra alguna cosa per error, també s’esborra al : \
mirall.

» No guarda versions antigues.

Exemple: Si afegeixes o esborres un expedient, el canvi es veu
al moment a l'altra estanteria.




(2. Copies de sequretat

COPIA TOTAL SINTETICA

Crea una nova copia total combinant la total anterior amb les

copies incrementals. COPIA S|NTET|CA
COMPLETA

» No recopia tots els expedients des de zero.

» Estalvia temps i recursos.
» Depen de tenir incrementals previes. 2 E g
, L : O
» El resultat és una copia total actualitzada.
_ , _ , Domingo Lunes, Martes
Exemple: Diumenge total; dilluns—dimarts—dimecres y Miércoles

incrementals; dijous es genera una nova total unificant totes
les parts.




(2. Copies de sequretat

COPIA INCREMENTAL INVERSA

Manté sempre la cOpia més recent com una copia total

actualitzada. COP'A INCREMENTAL
INVERSA

» Cada dia actualitza la copia total existent.

» Els canvis anteriors es guarden com versions antigues.

» Restauracié molt rapida (sempre total del dia). —_— !E -
» Requereix més treball en actualitzar.

Exemple: Diumenge total; dilluns s’actualitza a I'estat de Diumenge Di'zigrligs

dilluns; dimarts s’actualitza a I'estat de dimarts.




(2. Copies de sequretat

PROTECCIO CONTINUA DE DADES (CDP)

Desa cada canvi en el moment en qué passa, com si fos un

video en directe. PROTECCIO CONTINUA
» Registre continu de tots els canvis. DE DADES (CDP)

Permet tornar enrere a gairebé qualsevol minut.

— —

>
» Ideal per dades critiques.
>

No funciona per “copies del dia”, sino per linia temporal
continua.

16:21

16:20

Exemple: Siales 16:20 un expedient és correcteiales 16:21
t'equivoques, pots tornar exactament a l'estat de les 16:20.




CZ. Altres tipus de copies

B : EJEMPLO SENCILLO
TIPO DE COPIA QUE COPIA COMO SE RECUPERA CON EXPEDIENTES CUANDO USARLA

1. TOTAL Copia todos los expedientes Solo necesitas la Domingo: foto de toda la estanteria. Miércoles: Cuando quieres un sistema muy
(COMPLETA) cada vez. Gltima copia total. otra foto completa. simple y con pocos datos.

Domingo total. Lunes: un expediente cambiado.
Copia total + Ultima  Martes: se copian todos los que hayan cambiado
diferencial. desde el domingo (aunque el del lunes ya
estuviera).

Copia los expedientes
2. DIFERENCIAL cambiados desde la ultima
total.

Cuando quieres recuperar rapido
y los cambios diarios no son
muchos.

Domingo total. Lunes cambia 1 expediente.

+ § .
3. INCREMENTAL Cop@ los expedientes Cop!a total + todas las Martes cambia otro. Miercoles cambia otro. Cada IR GIETE: 'a horlr a.r espacio’y
cambiados desde ayer. incrementales. p : . . hacer copias rapidas.
dia se copia solo lo cambiado desde el anterior.

. A Normalmente no ha Dos estanterias iguales. Afades un expediente: Para sistemas que no pueden
4. ESPEJO Mantiene una copia idéntica y g P . que P

. que restaurar: el aparece en la otra. Borras uno: desaparece parar si falla un disco, pero no
(MIRRORING) en tiempo real. . .. i . .

espejo ya esta igual. también. recupera versiones antiguas.

5. TOTAL Construye una copia total Se usa la copia total Domingo total. L-M-X incrementales. Jueves: se Cuando quieres tener copias
S nueva usando la total sintética como si fuera  “monta” una nueva total mezclando domingo +  totales sin repetir el trabajo de
SINTETICA . . . .
antigua + incrementales. una total normal. cambios. copiar todo desde cero.

Actualiza la copia total cada La copia mas reciente  Domingo total. Lunes cambian 2 expedientes: la  Cuando necesitas que la Ultima
dia y guarda los cambios siempre es total y lista copia se actualiza a “lunes”. Martes cambia copia sea siempre total y muy
antiguos como versiones. para restaurar. otro: la copia total se actualiza a “martes”. rapida de restaurar.

6. INCREMENTAL
INVERSA

Guarda cada cambio en el  Permite volver atras a Si cambias un expediente a las 16:20 y te Cuando los datos son muy
momento exacto en que cualquier minuto del  equivocas a las 16:21, puedes volver a la version sensibles y no se puede perder ni
ocurre. dia. de las 16:20. un minuto de trabajo.

7. CDP (COPIAS
CONTINUAS)



GZ. Quin tipus fer servir?

» En funcid de les dades

» Total per a dades critiques,
incremental per a canvis constants.

» En funcid de l'espai

» Incremental si hi ha poc espai de
disc disponible.







2. Gravetat de les incidencies

» No sé on he deixat els documents

» Utilitzar el cercador i organitzar per carpetes.



2. Gravetat de les incidencies

» Laplicacio deixa de funcionar de tant en tant

» Actualitzar, tancar altres aplicacions i reiniciar el dispositiu.

!

S A i) [l



2. Gravetat de les incidencies

» No puc obrir I'aplicacié que necessito

» Reinstal-lar, revisar compatibilitat i consultar suports.

-

1




2. Gravetat de les incidencies

» No puc obrir cap aplicacié

» Revisar el funcionament del sistema i I'espai disponible.

| ¥

| '




2. Gravetat de les incidencies

» Lordinador no arrenca

» Comprovar la connexio, revisar la font d’alimentacio i
contactar amb el servei tecnic.
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(2. Tipus de connexid

» Ethernet
» Connexid per cable, rapida i estable.
» WiFi

» Connexid sense fils, permet mobilitat.




2. Ethernet

» Cable

» Connexio directa al router o switch.
» Rapidaisegura

» Menys interferencies que el WiFi.
» Ordinadors de sobretaula

» Preferida per a treballs intensius o jocs en linia.




LZ. Wiki

» Caracteristiques

» Ideal per a portatils i mobils, pot perdre qualitat amb
la distancia.

» Recomanacions

» Protegir amb clau WPA2 i millorar cobertura amb
amplificadors.




CZ. Altres tipus de connexid

» Dades mobils

» Connexio a través de la xarxa de telefonia, util fora de casa.




CZ. Altres tipus de connexid - PLC

» PLC (Power Line Communication)

» Utilitza la xarxa electrica per fer arribar Internet a
zones sense cobertura WiFi.




2. Connexid a Internet

» Ethernet

» Connexid estable per treballs amb alta demanda de
dades.

» WiFi
» Practic per a espais sense cablejat.

» Dades mobils

» Util en moviment, amb limits de cobertura i consum.




CZ. Com estem connectats?

» Barra de tasques (ordinador)
» Mostra I'estat de la connexio i accés a configuracio.
» Barra d’estat (mobil)

» Indica si hi ha connexid WiFi o dades mobils.




(2. Dispositius wearables

» Smartwatch

» Rellotge intel-ligent amb funcions de salut i
notificacions.

» Smartband
» Polsera de fitness per seguir l'activitat fisica.
» Smart glasses

» Ulleres amb realitat augmentada per experiencies
digitals.




(2. Els periferics

» Queée son?

» Dispositius externs que amplien funcionalitats de
I'ordinador.




7. Periterics d'entrada i sortida

» D’entrada:

» teclat, ratoli, microfon, camera web, escaner.

» De sortida:

» pantalla, altaveus, impressora.

» Hibrids (Entrada/sortida):

» Pantalla tactil, Router, Multifuncio.

HIBRIDS



7. Entrada o sortida?

» Entrada: GPS, accelerometre, giroscopi,
magnetometre

» Recullen dades com localitzacié i moviment.
» Sortida: motor de vibracié

» Genera alertes fisiques.
» Entrada/sortida: pantalla tactil

» Permet interactuar tant visualment com amb el tacte.
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CZ. Arxius digitals

» Queée son?

» Conjunts de dades emmagatzemats en formats que
els dispositius poden interpretar.

» Exemples:

» Documents (PDF, DOCX), imatges (JPEG, PNG), videos
(MP4, AVI), audios (MP3, WAV).

» Organitzacio:

» Es classifiquen en carpetes per facilitar I'accés.




(2. Carpetes i fitxers compartits

> Ca rpetes Compa rtides: Asistente para crear una carpeta compartida

Permisos de la carpeta compartida
» Espais accessibles per diversos usuaris en una xarxa. LoS permiss & perniten controlar quiénes) Personalizar permisos

Pemmisos de los recursos compartidos | Seguridad

> Se rvi d ors FTP . Selecdone el tipo de permisos que desea para |3 Mombres de grupos o usuarios:

(") Todos los usuarios tienen acceso de solo estel (WIN-SPCJADMIKEN estel)

(") Los administradores tienen acceso total;

» Plataformes per transferir fitxers entre dispositius. lectura

() Los administradores tienen acceso total;

(®) Personalizar permisos

| Agregar... || Guitar |

De forma predeterminada, en esta carpeta solo

» Permeten intercanvi directe d’arxius entre usuaris. compartidos. Para controlar los permisos deacg | o0 d¢ estel Pemitr _Denegar

haga dic en Personalizar v, a continuacion, mod Control total ]
ra aplicar permisos espedficos en la carpeta.
para aplicar pe - = Cambiar |

Leer Ol

» Xarxes P2P:




(2. Carpetes compartides

» Usuaris:
» Es pot limitar I'accés a determinats usuaris.
» Permisos:

» Es poden definir com a només lectura, escriptura o
modificacid.

00O
L e




7. Servidors FIF

» Transferencia de fitxers:

» Serveixen per enviar i rebre arxius
entre dispositius.

» Pagines web:

» S'utilitzen per pujar contingut a
servidors.

» Client FTP;:

» Programari que facilita la connexié
amb el servidor.

7§ 1]

=1
]

LA b . -
W e r “ rHlHillI- H I

LA hEife

LATHERE - "5 Fhll-rhnl:l:ll:lln
LAY ek S g unkoed = 2 diee e P e T e e ek 1

B Comsssf PAT D008 L0 LN

LIS i it el wa eEfa

il ol TEON WAL

Epilill I Dy dalr Swrre b "m Tty

el i | © e e Sl T e i i L L R e | s
- IJ.'“.-;\*. - — |.]|
= HAd s
4 o) e L) i
) Ewas — Hig
+ -.J'."'. mm‘hﬁ-
LT = (E fn

i“,., — T

ey g L L e
ol TR Fup b e
d.-.rrqu NN Foriaces b

JEN Por by e
AN P by bt
1ME  Foriske b
NN Poyiwtis hwes

Ja.".ll nu-_l-f

[ Cwecte | Comm e

Harplnif JTA0 &
L1 ey ey e T T o T [T i e ey el
RO LDl 900 1Y

L iwrrwren P Jia ) e et 'pokeaf 2
RO . e

L igme rmf-b:l'h:l:l._ﬂh::l'lm-'l

B ATh A0 Dy (3N 5l
Mo TR L bt ey

.
M0 e E FAL 194 i (I 1O

i I L e e Y L

Il Porasste . 20000
D Poriee e 200000
NN Poie lm 300000

PN M- R
IMd  Peises e i R

AN Foriw e 0000

4770 P e b 1005 i-l
e

| =l
—

| Qurwcdibies (1nen) | Buked i | Ssml vewien




LZ. Client FTP ——

Enter your FTP account details

. . s N FTP address: (i) FTP account
» Configuracio basica: P st rnomymous ogi
Password: -
» Adreca del servidor (ex: ftp.exemple.com), port 21 £TP prtocol — -
(FTP) o 22 (SFTP), protocol, usuari i contrasenya. Port: a [ Test FTP Connection |
Use passive mode Configure Proogy Settings (Optional)

» Interficie:

[Eave ][Cam‘&'l

» Permet arrossegar fitxers entre el dispositiu local i el
servidor remot.
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(7. P7P (Peer-to-Peer)

» Que és?

» Xarxa on cada dispositiu actua com a client i servidor
alhora.

» Avantatges:

» No cal servidor central; Util per compartir grans
volums de dades.

» Riscos:

» Pot facilitar la distribucié no autoritzada de
continguts amb drets d'autor.




(2. Compartir fitxers entre dispositius

Bluetooth
WiFi
Infrarojos

NFC

Missatgeria instantania
.i

vV v v v v Vv

Nuvol




7. Bluetooth

» Passos per compartir arxius:
1. Activar Bluetooth
2. seleccionar el fitxer

3. triar “Compartir” - “Bluetooth”

&3 Bluet

4. Connectar

5. acceptar




(2. Comprimir fitxers

» Objectiu:

» Reduir la mida per estalviar espai i facilitar
I'enviament.

» Formats habituals:

» ZIP, RAR, 7Z.

—
—
—_—

5.
o

» Avantatges:

£
|
!

CECCCCC

» Més rapidesa en la transferéncia i opcidé de proteccid
amb contrasenya.




(2. Comprimir carpetes

» Processos:

» Agrupar diversos fitxers dins una sola
carpeta comprimida.

» Us habitual:

» Enviar projectes complets o fer
copies de seguretat.




(2. Passos per comprimir un fitxer

» Menu contextual:

1.

2.

3.

Botd dret sobre el fitxer

“Enviar a”

“Carpeta comprimida”.

» Assignar nom i acceptar:

1.

2.

Posar un nom clar

Confirmar l'operacio.

SELECCIONEU AQUESTA .

oPCIO!

{ Carpeta comprimida (en zip)

" Destinatario de correo

- Destinatario de fax
Destinatario de fax
Dispositivo Bluetooth
Documentos

Escritorio (crear acceso directo)

| @ Generar huella digital con AutoFirma

Andar al Acceso rapido

Abrir como Bloc de notas en OneNote

Ea Examinar con Windows Defender...

Conceder acceso a
Restaurar versiones anteriores
Incluir en biblioteca

Anclar a Inicio

Enviar a
Cortar
Copiar

Crear acceso directo
Eliminar

Cambiar nombre




(2. Fitxers comprimits

» Formats habituals:
» ZIP, RAR, 77Z.
» Avantatges:

» Estalvien espai i permeten enviar diversos fitxers
junts.

[ Archivo Zip Wind owes ] [ﬁ.rchiuuWinElF‘ ] [ﬁ.rchiuuWinHﬁ.H ]




A LA
SISTEMA OPERATIU

MANTENIMENT

P i
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7. Actualitzar

» Pegats:

» Correccions especifiques per vulnerabilitats.
» Millores:

» Afegeixen funcionalitats o optimitzen I'Us.
» Seguretat:

» Protegeixen contra ciberatacs i errors.




(2. Actualitzacions de programar:

» Vulnerabilitats:

» Les actualitzacions corregeixen forats de seguretat.

» Errors:

» Resolucié de problemes que afecten el
funcionament.

» Millores de producte:

» Incorporen noves funcionalitats i estabilitat.




(2. Manteniment de maquinari

» Components fisics:
» Discos durs
» Memoria RAM
» Ventiladors.
» Accions clau:
» Netejar periodicament

» Controlar la temperatura.



(2. Manteniment preventiu

» Fisic:
» Neteja adequada i manipulaciéo amb cura.
» No fisic:

» Eliminar apps innecessaries i fer actualitzacions
periodigues.




[Z. Manteniment correctiu

» Problemes habituals:
» Fonts d’alimentacid
» Memoria interna

» Targetes de video




(2. Instal-lacia de programari

» Condicions:

» Compatibilitat de maquinari

» Memoria lliure (Espai de disc dur)
» Memoria interna (RAM)

» Capacitat d’execucid (Processador, tarja grafica, de
so...)

» Compatibilitat de sistema operatiu

112




(2. Instal-lacid d'aplicacid al SO

» Pas a pas

>

vV v v v v Vv

Visitar Lloc oficial

Comprovar-ne la seguretat
Comprovar-ne els requisits
Descarregar el fitxer d’instal-lacié
Executar el fitxer

Acceptar les condicions

Seguir les passes d’instal-lacié i configuracié

INSTALL...




(2. Instal-lacia d'aplicacia a 'smartphone o tauleta

» Pasapas
» Obrir la botiga d’aplicacions del dispositiu
Registrar-se/autenticar-se
Cercar l'aplicacio
Prémer l'opcid Instal-lar
Acceptar les condicions

Obrir I'aplicacio i atorgar-ne els permisos

vV v v v v Vv

Comprovar-ne el funcionament




[Z. Recorda

» Consell clau:

» Verifica 'origen i llegeix les condicions abans d’instal-lar programari.




(2. Programari de sequretat

» Antivirus:
» Detecta i elimina programari malicios.
» Tallafocs:

» Controla connexions entrants i sortints per evitar
accessos no autoritzats.

ANTIVIRUS VS FIREWALL

Les diferencies que necessites saber

Antivirus Firewall

Protegeix el dispositiu Impedeix que invasors
contra amenaces accedeixin al dispositiu
a traves de la xarxa
* Detecta

e Prevé  Controla

. Elimina » Bloca
* Permet acces

7\




2. Unitats de mesura

1ol

1 byte (B) 8 bits

1 kilobyte (KB) 1000 B

1 megabyte (MB) 1000 KB

1 gigabyte (GB) 1000 MB
1 terabyte (TB) 1000 GB




2. Unitats de mesura

KB MB GB TB

Concepte Bit Byte (Kilobyte) | (Megabyte) | (Gigabyte) | (Terabyte)

Un digit Petit text o Fitxer Fitxer de Grap
.. Una lletra o . s : quantitat
Representa binari . document multimedia  gran mida o .
caracter : , d'arxius o
(0o 1) curt petit video curt ,
videos
. 8 bits 1.000 Bytes 1.000 KB 1.000 MB 1.000 GB
. Informacio
Equival minima = = = = =
1 Byte 1 KB 1 MB 1GB 1TB
250

Exemple Una resposta =i 8238 EUI: 1 minut de 15 minuts de  pel-licules

practic binaria iz {aeli e musica MP3  video FullHD 0 200.000
nota breu) fotos



2. Unitats de mesura

Velocitat |matges

de
processador
. pixel
1 megapixel
1 GHz un milio
un milié de de pixels

cicles per segon
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[3. Xarxes

» Dispositius interconnectats
» Equips connectats entre si per compartir dades.
» Protocols

» Regles de comunicacié com TCP/IP.




C3. Tipus de xarxes

Sigla

PAN

LAN

MAN

WAN

GAN

VPN

NMom complet

Personal Area
Metwork

Local Area
Metwork

Metropolitan

Area Metwork

Wide Area
Metwork

Global Area
Metwork

Virtual Private

Metwork

+ Us principal

Connectar dispositius
propers a una persona (ex:
mabil amb smartwatch o

auriculars)

Xarxa dins d'un espai petit:

oficina, aula, casa

Xarxa entre edificis o
centres d'una ciutat

(universitats, hospitals)

Xarxa que cobreix arees

molt grans (com internet)

Xarxa que cobreix tot el
planeta (sindnim tedric

d'Internet)

Xarxa segura dins d'Internet
per connectar-se com si
estiguessis en una xarxa

local

Funciona a la

practica?

Si, pero es fa
servir sense adonar-

nos

Si, molt usada

Existeix, perd sol
estar gestionada per

grans entitats

Si, és la base

d’'Internet

> Més tedrica que
practica (Ja ho
cobreix la WAN)

Si, molt usada
per treball remot o

privacitat

~~ Habitualitat

+ Poc habitual com a
concepte, pero si en

I'Gs
@ Molt habitual

+ Habitual en
entorns publics o

grans organitzacions

@ Molt habitual

{estructura global)
¥ Quasi no s'utilitza

com a terme

@ Habitual i practica

P




(3. Configuracic de connexid a la xarxa

» Adreca IP
- .Adrega P 192.168.1.20
. Es un nimero que identifica
» Mascara de subxarxa un dispositiu en una xarxa.

» Porta d’enllag
Mascara de

» Servidors DNS subxarxa M
Indica quins dispositius w
son de la mateixa xarxa. 255.255.255.0
Porta d’enllac
Es el dispositiu que connecta
la xarxa a altres xarxes. = i
Servidors DNS

Tradueixen noms de lloc web
a adreces IP.




(3. Adreca [P

» Adreca Unica
» No es repeteix dins la mateixa xarxa.

» Protocol d’'Internet

» Fa possible la comunicacio entre dispositius.

» Cadena numerica

» Format habitual: 192.168.1.1




3. Mascara de subxarxa

» Classifica les IPs
» Indica quines adreces son de la mateixa xarxa.
» Permet segmentar xarxes

» Ex: 255.255.255.0 admet fins a 254 dispositius.

Clase | Bits | IP Subred | IP Broadcast | Mascara en decimal CIDR
A 0000 | 0.0.00 0.255.255.255 255.0.0.0 /8

B 1000 | 128.0.0.0 | 191.255.255. 255 | 256525500 16
C 1100 | 192.0.0.0 | 223 255 255 255 | 2565 255 255 0 124

D 1110 | 224 .0.0.0 | 239 255 255 255 | 265 255 255 255 132

E 1111 | 240.0.0.0 | 255255 255 255 | 265.255 255 255 64

P



(3. La porta d'enllag

» Encaminador (Router)
» Envia dades entre xarxes.
» Implica seguretat i configuracio

» Permet controlar ports i accés.




(3. Configuracic de la connexia de xarxa

» Des de el sistema operatiu
Estado

Estado de red

=

» No cal programari extern.

» Taulell de control

i—®

Totalplay-B6A0

» Permet configurar la xarxa (Windows, Mac, Linux). b i

Estas conectado a Internet.
Si tienes un plan de datos limitado, puedes convertir esta red
en una conexién de uso medide o cambiar otras propiedades.

Cambiar tas propiedades de conexion

Mostrar redes disponibles

Cambiar la configuracion de red

@ Cambiar opciones del adaptador
Visualiza los adaptadores de red y cambia la configuracion de
conexidn.

% Opciones de uso compartido

Decide qué quieres compartir en |as redes a las que te conectas,

‘Solucionador de problemas de red
Diagnosticar y zolucionar problemas de red.

128

! £ Escribe aqui para buscar (0] ﬂf e .m ‘ ﬁ @ fos

Ver las propiedades.de red




(3. Pregunta i resposta

» Cal descarregar cap aplicacio per configurar la
xarxa?

» No, es fa des del sistema operatiu.
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(3. El navegador

» Aplicacio per accedir a Internet

» Exemples: Chrome, Firefox, Edge, Safari.
» Hipervincles

» Enllagos per navegar entre pagines web.
» Adreces web (URL)

» Identificacio Unica d’'una pagina
(ex: www.google.com).




[3. Els cercadors

» Servidor informatic
» Llista de resultats
» Algoritmes
» Rastreig i indexacio

» Paraules clau

Yan de R WolframAlpha e YAHOQO!

e Balé&EE

peekier AOI

Startpage com

DuckDuckGo

55 EXALEAD \fa ctbltes

Where resulls make sense



(3. Motors de cerca

» Robots (aranya web)
» Rastreig de servidors web
» Paraules clau (keywords)

» Ordenacio de resultats

133



3. Canviar el motor de cerca

» Configuracio
» Permet triar el motor predeterminat. yahool
[
» Opcions disponibles
» Google, Bing, DuckDuckGo, etc.

» Millora de la privacitat Yandex GO Ogle

» Alguns motors no rastregen l'usuari.

Bai&?. BE

lifeder)

WolframAlpha




3. Canviar el motor de cerca (exercici)

» Exercici practic:

» Canviar el motor pel de Wikipedia i observar els
resultats.




3. Cercar informacic

» Cerca general
» Cerca avancada

» Cercadins un portal




(3. Cerques avangades

Totes les paraules
Paraula o frase exacta
Qualsevol paraula

Cap paraula

vV v v v VvV

Sequéencia numerica




C3. Trucs per filtrar les nostres cerques

>

>
>
>
>

1. Entre cometes les paraules per indicar frases
exactes

o »”n

2. Excloure paraules amb el signe “-” i forcar la
inclusio amb “+”

un

3. Usar el comodi
4. Combinar termes amb “OR” o “|”
5. Buscar amb rangs numerics amb “x...y”

6. Buscar alguna cosa dins d'un lloc web amb “site:”
o excloure-ho amb “-site”

7. Buscar documents d'un tipus determinat amb
“filetype:”

Comillas dobles (")

Para buscar frases exactas

Signos “-" y “+”

Para excluir y forzar palabras
respectivamente

Asterisco (*)

Se usa como comodin

Rangos ("x...y")

Para buscar rangos numeéricas

“site:"” o “-site”

Para buscar dentro de un sitio web
o0 excluirlo dentro de la bdsqueda
“filetype:”

Buscar documentos especificos
con la extension que se indique

- le

Comando ‘OR’

Para resolver dudas de escritura
entre palabras

Simbolo ~

Encuentra palabras similares a la
propuesta

Texto "allintitle"

Localiza las paginas que contienen
las palabras clave en el titulo




(3. Tipus de cercadors \

VERTICALS
GENERALISTES DIRECTORIS (ESPECIGLITZATS METACERCADORS

GO:::’;g le  YAHOO! { IMDb l habitaclia

biing | g trivago

Rastreator

-



(3. Desar pagines web

» Accés sense connexid Comrdar com
< . N <« Ejemplos de... » Curso Word v 0 Buscar en Curso Word
» Es poden desar com a HTML o pagina
Comp|eta. Organizar = Mueva carpeta X S ow 0
22 Dropbox Mombre Fecha de medifica... Tipo
» Utilitat & OneDrive Doc._maestros 01/02/201614:25  Carpeta d
unidad1é 01/02/2016 14:24 Carpeta d
. . I Este equi
» Util per consultar estudis o documents ==
importants offline. o Red v < >
Mombre de archivo: | aulaClic.htm V|
Tipo: | Pagina web (*.htm;*html) v|
Autores:  aula Clic Etiquetas: Agregar una etiqueta
[ ] Guardar miniatura Titulo de la pagina:
Carnbiar titulo...
~ Ocultar carpetas Herramientas Guardar Cancelar




(3. Desar accessos a pagines web

Marcadors
Preferits
Llista de lectura

Marcadors socials

vV v v v VvV

Accés directe




(3. Navegacid privada

» Mode incognit

» No desa: historial, memoria cau, contrasenyes,
formularis ni galetes.

» Limitacions
» Els llocs web poden seguir rastrejant I'activitat.
» Utilitat

» Permet accedir a comptes diferents sense tancar
sessio.

» Privacitat parcial

» No protegeix contra la vigilancia en linia.




(3. Pregunta i resposta

» Es poden fer servir contrasenyes desades en mode privat?
» Si, el navegador pot accedir-hi igualment.

I |




(3. Pregunta i resposta

» Puc avancar o retrocedir entre pagines en mode privat?

» Si, la navegacio funciona de manera normal.




(3. Compartir continguts

» Citar la font
» Respectar 'autoria i la credibilitat.
» Enllacar
» Evitar copiar contingut sense atribucid.
» Respectar 'original
» No modificar sense permis.
» Consultar l'avis legal

» Comprovar si és legal compartir-lo.




[3. Llicencies ((is)

» Exercici practic

» Estem cercant imatges de policies per a preparar
presentacions de futurs cursos, visiteu les seglients
pagines i digueu si podem fer servir les imatges que
hi apareixen per a la nostra presentacio.

» https://mossos.gencat.cat/ca/inici

» https://ajuntament.barcelona.cat/guardiaurbana/es/
somos-mujeres-somos-urbanas

» Les podrem fer servir per als cartells de difusid a les
xarxes?

» Verificar drets d’us

» No totes les imatges tenen llicencia lliure.



https://mossos.gencat.cat/ca/inici
https://ajuntament.barcelona.cat/guardiaurbana/es/somos-mujeres-somos-urbanas

(3. ldentificar una web sequra

» Cadenat

» HTTPS

» Evitar webs sense HTTPS

&k hitos://




(3. baletes (cookies)

» Que fan?
» Recordar accessos
» Habits de navegacio

» Es poden gestionar i eliminar

Cookies

Lorem ipsum dolor sit amet...




C3. NAVEGACIO | COMUNICACIO EN EL MON DIGITAL

~ EL CORREU ELECTRONIC-



3. Consultar el correu web

> Principals serveis: (TR S

» Gmail

» Outlook

» Yahoo Mail

» Accés des de qualsevol
dispositiu amb Internet



3. Correu electranic

No requiere ningun T
7T\ Para poder escribir
software S d I I emﬁar mensajes ¢
WWW independiente. Basta e puede consultar e debemos estjar
N\ con ir al sitio web del correo desde e
plavescor elg corfao. culalqu[er_dlspDSItwo cc?nec:tados a Internet
Web il iniciar sesién y ver los & SCEGTICO Carntn
ebmal mensajes de correo navegador.
Se requiere un Funcionan a traves de
| rograma . :
il B cg:l t Permite gestionar un protocolo (POF'? 9
- iIndependiente, que IMAP) que determina

hay que configurar varias cuentas de .
correo a la vezy de como se almacenany

con la cuenta de h i i
forma sencilla. visualizan los

. correo, para consultar mensajes.
Cllente de los mensajes de

correo correo




(3. Passes per enviar un correu

1. Redactar el missatge
2. Afegir destinatari/s
3. Escriure I'assumpte
4. Introduir el contingut

5.  Adjuntar fitxers si cal

N i
& RetBetar L |
s
Pt TRk oy -
Ao

1

@ oo e R - %

giw e ey e ielp
% d Fgeh b KDL R
G z xc v b nmig

na @ e : n

v L u

CIE S I - R T O B
@ zxcvbnam@

na 2 @ 1w - . g £ ; u
=1

R S

B ssando el cosres

et dil doinie
Al prmd aporiis bete mus Lang

\

3

b lepo ger  bprirse B
W 0 e el e
| EcdifF gl FEREILDR

%% z.x ¢ v b onmiE

v o m




3. Elements essencials en |'enviament d'un correu electranic

>
>
>
>
>

Destinatari/s
CC/cCco
Assumpte
Signatura

Documents adjunts

Exrasan
Dz « Remitent
Eang

i Destinataris

= Amb chpla

S Amb copla oculta

Asumtn:  Assumpte
Sudpniar v archay
B 75 UFaTHT o mi|siOM0GESET lup

Cos del missatge




(3. Organitzacid i gestia del correu electronic

» Destacats
» Etiquetes
» Filtres

» Resposta automatica

pia | Informa d'un ermor | Sur

Carca al comeu

fd [23 Gpoar e

1 felty

. y Acceés a |a resta de
HTEC  serveis personalitzats
“de la XTEC

Cerca al wab

Configuracio
del correu

Arxchea | Marca eom 3 basss | Saorimeis Mouaw  Etiquetss » Més accions w Aclualitza

Safates principals 1-8deB

Destacais o, Missatoes destacats Sense destacar
F:t%:' - @ 7 a— (D) [servei TAC] Exemples plantilles Goog 27 d'abr.
— S LaMostra 2.0 (admsites@utec.cat) = 18 d'abr,
al rEtEEs Request to share saga - = u==t 10 shal & d'abr.
Safates : Request to share saga - ~couect 10 zha 4 d'abr.
de missatges [servei TAC] Xarxa social Skype Ino ¢ 31 de marg
amb B!iqUBtBS quest to share saga - ~oou=si o cha 31 de marg

sa Lleixa is now following you on 1 30 de marg

Re to share saga - ==qusst 1o sha 28 de marg

Selecciona Tots, Cap, Liegits, No llegit; Missatges destacg, Sense destacar

ergue |'.'_' [ ..li.lJ..
il -2k = Arxiva  Marca com a brossa | Suprimaix Mouaw | Etiquet

T

Msas accions » Actualitza
1-8de8

Servel de Tecnologia
Niiquey estal

Zona de converses
LM | fat
21 issatge en una nova finestra, prem !:53 a]

Actualment esteu utilitzant 0 MB dals vostres

Damera activiat del compte: fa 20 minuts en agquest equip. Delals
Wista de Correar: eslandard | dasactiva ol xat | HTML basec Més informacit

E2011 Google - Condicions d'Gs - Nomes de pradess - Mormes del programa - Paging dinici de Google

Alsgasy win

conlacts



(3. Filtres de correu

» Funcionalitats
» Classificar

» Reenviar

» Millora la productivitat

3, Butear cones 1

Configuracion

Gongral  Erfigoutss  Becibidos  Cuam flergs  direccisnes Biagusada

Reermlo v correo PORYMAP  Complemsenios  Chat Configuracion avanzads Sinconodlon Temes

Los siguientes Hilbres sa aplican a tedo ol comes eniranle

Sz, Ty, Mads
Exgsasi Elrmixar

Crogryn o bt liltros

S ham Bloqueads s de corred. Lot menssies enviades pal s506 remitentes

ST N thees ninguna direcoidn bloqueada

Todo, Mads
Dasbdac i lak gressciigs upliessnadi



(3. Passes per crear un filtre

» Configuracid/Ajustaments
» Filtres i seguretat = P Gl i o
2 Redactar g- ¢ i Ajustes rapidos X B
» Crear filtre nou — G ekl g Promecones @EED g soqi ‘.' Ver todos los ajustes o
Recibidos Jtéite, The Hootsute Tasn ]
. . ¥r Destacados 2 — Aplizacicnas an Gmail @
» Establir automatismes © Pospuesios Chaty Mest :
B> Enviadas La pestafia Principal est4 vacia, Ressansiizar -
. . D EBorradores ui 58 muestran los mensajes que RG aparecen an otras pestafias,
> AJ u d a a geSt I O n a r CO rre u S L :‘ uisres afiadic o efiminar eatqaﬁas ha: clican la confi Emcién da Recibidos. e
. . o - = @ Predeterminad s | +
de forma eficient Etiquetss +
O Coémods
Términca - Privacidad - Politica del programa D S
0GB oeupados 425 GB [ . o




¥

(3. NAVEGACIO | COMUNICACIL .EN EL N DIGITAL
COMPARTIR AL NOVOL.



(3. Emmagatzematge al naval

» Accés global
» Sistema extern
» Copia de seguretat

» Compartir en temps real




(3. Calendaris online

» Gestionar esdeveniments

» Reunions, cites i recordatoris

Google Calendar

Janusry £078 L4 ¥

M T W T F B 5

1::°||:

B L] w8 1 1l 4

oW o oW oW owm on

Add a friend’s calendar +
My calendars ~
Dave Taylor
Birthdays
B Reminders
Other calendars -
England
CC Meals & Programs
Holidays in the United States
B Holidays in United States

TODAY <

Ban
Jan 1

City Chub Choasd
Few Yoar's Doy
Mew Yeur's Day
TRASH & COMPST

8

s January 2018
Tue Wed
2 3
i ey Want's Birthdoy & Minty Momtuna'y birth

9

& Beau Coffron's birthds

& Scolt Converse’s birth

 TRASH & RECYCLING.
Zoum Flight 10 Las Viegas

TRASH & RECYCLING.

& et N
T

® 12pm Sooial Lunch

16

10arm Debbie Peren clea
& 12pm Sooial Lunch

23
s D oy bithaay
& Folx Holzapfels birth

® 12pm Socdal Lsnch

30
i Waihinn Engais’s Bithi
# 12pm Social Lunch

2 g Slevn Quiting's Barihda

pn Kids with me

10

@ 12pm Applied Mysticisn
i Apm Kids with me
2pm |COFest & LaunchF

17

@ 12pm Ennsngram with £
¢ Zpm Kids with me

24
Apm Kids with me

31
e I Tawals Birthd
Ipm Kids with me

Thu

2pm Kids with me

n

& Matt's birthiay
® 12pm Social Lunch
Zpm Kids with me

18
# 12pm Sceial Lanch
2pm Kids with me

25
& 1ipm Soclal Lunch
Zpm Kids with ma

Feb 1

Fri
5

3pm Klds with me
& 5:30pm Happy Hour

12

2 Leosa Bames's binthd:

& Sam Robertss birthda
3pmn Kids with me

& S300m Happy Hodr

19
dpm Kids with me
& 5:30pm Happy Hour

26
Aprm Kids with me
& 5:30pm Happy Hour

z

1pm 2018 DAD 2.0 SUMMIT

# 12pm Pheasure Circle
» 12pm Social Lunch
Zpen Kids with me

Apen Kide with me
& 5:300m Happy Hour

Month = ﬂ

S8l
-]

o dam Kids with me

13

& 3:10pm Flight to Denver

20
+ dam Kids with me

T

# |pm Instagram Bast Pra

© Gam Kids with me

°@

Barn Kids switch house

14

£ Maslena Payniar's birt
¢ 3pm 5RO DED: "Trees 4

21

¢ Barn Kids switch house

28
Ipm SRO DED: Trees 4

4
¢ Barn Kids switch house



(3. Compartir calendari S —

Wil o Ver los detalles de fodos los eventos

; dgmail.com Realizar camilos y adminlstiar &l uso co r

©
L
» Amb persones concretes !
. - Realizar camblos eneventos = X
A
o

gmall com

. ! Realizar cambios en eventos = »
| Sgmaik com

» Amb membres de l'organitzacio

- ,‘t'”,'a‘l'l 6 Realizar cambios en eventos =

» Public peratOthOm % ARADIR PERSONAS -

M informacibn sobre cdma compartin U caleraatio con aldguien

& Configuraciin

S
A Prerar sttt 0 D)

Adamr ralemdlaran - L| Comparis plbicameTms W 8 Dbl v lodcs s Poeries -

b Rapeial
e wnisin pora compaTe

wa

Carfigurackin damin S P
i
LB -

Eompartlr comdilermaradars fjorspngs

Coordapr nowiin. g Caberchar

' isbiadl el prrasdl raem | Pt S |
I Pl il o BT

Cormpartr con fmErsnasien & Afiacr paraoran
ke bl b

Nl agisman S8 Fvanina

Fetfront rorre e rreii
¢ todc el dea

Rogilcocnneg ol averions.
HirkfeEaciarrs pereTEe

imingrar ol calerdais Fotifs g,




(3. Compartir calendari (gestid)

» Mostrar lliures/ocupats
» Afegir detalls

» Modificar esdeveniments

» Gestionar accessos = [J Ciencbiic  sw <> SeplienbreI0n

on FTT [T i
Septiambra 2003 E A Zartcy
. s i
P N T : Fuera de la oficina
voreen | Lixen | Dipsl S
™o om0 T 1 L} HO = W =] T Frapméstion [ivdarsorisls
‘ FO ¥ a " Al Sverto.  Fugradalsafising  Tarps  Hesstion sieponisies T
T AR T, e By 1030 = 15-Fm
)
m R On o&mo@ W A D ueess @ seooemise 1000aE - 11000
O @ B MW ¥ o1
[ Tosw stz
TR || T S+ Agua | Firely Videt Moo 28 pegie o
it _

B Bechugs munion ey mosmiticaments

l:_:] Solo FIeTSOSne N & OSSR E SRS

: i [0 R ifasnss Slafri v @ e linesd

b ealenaivio: - o
el
@ s
[EInE

LI B Deciined becisme Fam o of office
[ Gemacis r

- Peabitzn ™
L] mri b eamiain " E @
O Masernavcas £ a4 a1 oD en s e o Goonie
[ aaterrgicas 2o ]
O Pira de conienids iy
] Presbn

0O secoedinsnca
L




(3. Passes per compartir calendaris

1. Obrir Google Calendar
2. Crear un nou calendari

3.  Configurar permisos i compartir

= Calendar Hoy < > Agostode 2019 Q ® ©
Dom LU MAR MIE JUE VIE

I.. Crear 28 25 3n k3] 1 de age 2

Agosto de 2019 £ 3

o L m x 4 v 8

2 2 W N v 2 3
4 5 6 7 8 9

4 5 & T 13 9 1o e 1
2l Bl Reunidin 10:50am Pedintra Gabriels
1" 12 13 0 15 16 7
w13 o oW om oH M b4
25 T Gz s ial X @ Anade un titulo
1T 2 3 4 5 & 7 0 15 16
Evento  Recordatorio @ 5:300m (Sin titulo)
(@ Jddeagode?19 530pm - §a0pm 14 de ago de 2010
Mis calendarios ~ 2 Afade invitad
h fade invitados 21 22 23
a Carlos Ferer-Bonsoms
@ Afadir ubicacidn o confereglias
@ Calendario de pruba
=  Anade una descripcion
u Cumpleanios
H Recordatoriss B @ calendario de prueba ~ | : !
28 29 30

[ Tasks
Mas opciones 4
Otros calendarios + A

[[] Festivos en Espafia




(3. Calendari amb ['organitzacio

» Només lliure/ocupat

» Detalls dels esdeveniments

Ver solo libre/ocupado (ocultar detalles) + X Compartir con determinadas personas

Ver solo libre/ocupado (ocultar detalles) X st Msipnassiio oo Geatiod
¥ - letalles S BVEMDS ver tooos los detelles de los eventas
H ATBIOS en eventor Hager cimbios %E:l“tmm
B Hacer cambiosy gestionar of use compartido




(3. Calendari pablic

» Nivell d’accés
» Es pot configurar segons permisos.
» Persones no usuaries

» També poden accedir-hi si s’habilita.

¢ Configuracion

General
Agregar calendario v

Importar y exportar

Configuracion de mis
calendarios

@ Xavier Lopez De Pablo
@® Batxillerat 4 ESO A

® Cumplearios
@ GRABACION DE DATO... A

Configuraciéon del
calendario

Aceptar invitaciones
automaticamente

Permisos de acceso para
eventos

Se compartid con

Notificaciones de eventos

Notificaciones de eventos de
todo el dia

Otras notificaciones
Integrar calendario
Quitar calendario

® Ofimatica Informatica

@ SEO Digital

Configuracion del calendario

Mombre
GRABACION DE DATOS (MFO973) Surge 2020

Descripcion

Zona horaria
(GMT+00:00) Hora universal coordinada

( Exportar calendario )

Obtén mas informacion sobre como exportar tu calendario

Aceptar invitaciones automaticamente

Agregar todas las invitaciones a este calendario de manera automatica

Los calendarios de recursos pueden aceptar invitaciones de manera automética. Mas informacion sobre la
aceptacion automatica de invitaciones

Permisos de acceso para eventos

[0 compartir de forma publica Ver tc

K Obtener vinculo para compartir )

Obten mas informacion sobre como compartir tu calendario




(3. Passes per compartir document en linia

1. Obrir el fitxer

2. Opcidé "Compartir"

3. Seleccionar usuaris i permisos
4.  Escriure missatge opcional

5. Acceptarienviar

Compartir “Introduccion a la IA - ® @«
Completo.pdf*

|Afiadir personas, grupos y eventos de calendario

Personas con acceso

&l Xavier Lopez De Pablo (you)
{aall

xlopezdepablo@gmail.com

Acceso general

Cualquier persona con el enlace ~
Lector

Cualquier usuario de Internet con el enlace puede verlo

() Los lectores pueden ver los comentarios y las sugerencias

¢ Copiar enlace




(3. NAVEGALID | COMUNICGAGID EN EL MON DIGITAL
b EINES LUL-LABORATIVES



[3. Eines callaboratives

» Chat
» Forum
» Blogs

» Wiki




(3. Consells per participar en una tertilia

Ortografia i gramatica
Evitar majuscules
Respectar els altres
Comunicacio clara i concisa

No sortir del tema

Xat en privat

vV v v v v v v

Discrecid i privadesa




(3. Normes de participacid

» Majuscules
» Emoticones
» Centrat en el tema

» Ser respectuds

No e+'ique+c:qr'
a otros sin
su Per'rnif-:-o

No mentir
No compar’rir‘
Foke news

Citar y
enlazar las
fuentes

Una bio para
identificarse

Empleo

coherente de
gt
emoticonos

Ne+ique+a er'l.

redes socidles ser pacificos
No fomentar

la viclencia




3. Asincrone i sincrone

» Sincrone
» Comunicacio en temps real (ex: trucades, xats). [ _ - I ‘ =
Sincronico | Asincronico
» Asincrone . L.
_ , _ e Chat e Correo
» No requereix resposta immediata (ex: correu, _ P
\ e Audio electronico
forums). - _
conferencias ® Foros
¢ Video e Wikis
conferencias * Blogs
¢ Messenger * Grupos
e \/ideo llamadas

—




(3. Pregunta i resposta

» Un xat és una eina asincrone?

» No. Es una eina sincrone perqué la comunicacié és
immediata.

» |un forum, és asincrone?

» Si. Permet llegir i respondre quan es vulgui.

» Que fer davant un avis de Wikipedia per no estar
identificat?

» Crear un compte per privacitat i funcions addicionals.




[d. R3S

» Really Simple Syndication
» Actualitzacions automatiques

» Util per noticies, blogs i podcasts




(3. Sindicacia de continguts

Disponibilitat a la web

Algunes webs ofereixen canals RSS.
Lector RSS

Aplicacio per gestionar subscripcions.

Donar-se d’alta

vV v v v v Vv

Permet rebre notificacions de contingut nou.




(3. Fitxers digitals ((s)

» Copia de seguretat
» Us personal legitim

» Respecte als drets d’autor




(3. Tecnologia NFG

» Comunicacio sense fils de proximitat
» Transmissio rapida d’informacio
» Distancia curta (fins a 20 cm)

» Us habitual en pagaments contactless




(3. Tecnologia PZP

» Comunicacio directa entre dispositius
» Sense servidor central
» Cada usuari pot ser client i servidor

» Exemples: torrents, criptomonedes, Skype

Estructura
Cliente-Servidor

s 53
| & \

Estructura P2P




(3. Trucades de veu |P i videotrucades

» Mitjancant Internet (VolP)
» Exemples: Skype, Zoom, WhatsApp

» Redueix costos i és flexible




(3. Us del GPS i ubicacid

» Geolocalitzacio
» Aplicacions de mapes
» Planificacio de rutes

» Compartir ubicacio en temps real




Ld. Codis (R

» Emmagatzemen informacio
en format grafic

» Escanejables amb camera

» Us habitual: enllacos,
pagaments, identificacio




(3. Diferents protocols de xarxa

» HTTP
» DNS

> FTP




Ld. [PTV

» Televisio per Internet
» No depen de canals tradicionals

» Contingut ala cartaien directe




C3. NAVEGACIO | COMUNICACIC EN EL MON DIBITAL
tL PROGRAMARI MALIGIOS



(3. El programari malicias

Virus

Cuc

Troia

Programari espia

Adware

vV v v v v Vv

Ransomware




o
[a
|
¥ -'
4 r |
- _-"“"H =
_— ' g "
| ]l

E4 TRAETAMENT []E LA \NFI]RMAE\[I ESER\TA



C4. TRACTAMENT DE LA INFORMACIO ESCRITA

tS [RUGTURA DEL BUGUMENT




4. Estructura del document

» Estils de titol o encapcalament

» Nivells d’esquema




(4. Taula de contingut

vV v v v v Vv

Index automatic
Estructura

Titols o encapcalaments
Estils

Numero de pagina

Enlla¢ a cada apartat

-

Tabla de
contenido ~

Pagina 1 de 1

Archive  Inicio

. Iﬁ Agregar texto v

Di Actualizar tabla

Insertar

Tabla de contenido

50 palabras

il Autoguardado @ [H] Documental - Ward

Dibujar  Disefio  Disposicion Referendm Correspondencia  Revisar  Vista Ayuda H Comentarios = [Jel]iyfvr el diRg
r']lnsertar nota al final Q @ D & Administrar fuentes Insertar Tabla de ilustraciones ‘D .
Insertar at Notaal piesiguientesrx Buscar Investigador = Insertar |—T_' Estila AP Insertar D neluiizarinkis Marcar !
nota al pie [ ostar nats cita~ [T Bibliografia ~ titulo [ Referencia cruzada entrada
Motas al pie P Investigacion Citas y bibliografia Titulos [ndicz e
Eia D!Actualizartabla...|
Conten |d‘o
TR0 ussussnincnusouccacimiavyunnruusnasiei s o S L R R A A e RS 1
THEUNO 2 st s e o B T S A S R T S B L S e ey 1
THEID 20N . rsccnnmsmssnmsensasmanensnsnn st ns s sy e AR A AR SR AR SRR A RS S ST 1
U022 s sems s toms s s nme s S S s e S S e A A S A S A S S s e A A RS 1
g £ 11 B R 1
THEUIE D22 cnccmcsnisvimsesnssinioes o 50 2k o4 3 2 S 00 R R R G 1
L 1
THEUTO 20 s o oot s S e s e S T R R s e i
(L8371 e 7 1 RS U SN SO S U S5 UURSUUUY RS SOOI SN S O 1
—

o

2 Buscar (Alt+Q)

Edgar Otero ° ﬁ

Predicciones de texto: activado ﬁ,nccesibilidad: todao correcto

[, Concentracién

B -———H#—+ w60




C4. [ndex alfabetic

» Seleccionar entrades
» Marcar-les
» Posicionar el cursor

» Inserir I'index




C4. Espais

» Espaiat

» Interlineat

» Separacio entre paragrafs
» Sagnats:

» Primera linia

» Francesa

Documentol - Word pe) Diego Cérdenas Dev

rrafo einterlineado,;.... revicor  vis  augs = o

Autoguardado (@ ) E’] "{__)- ¢ty =

Archivo Inicio Insertar OPCiones de P

fﬁ] A | Al g v i=Evi=y =y &= E ’y 0 @J 4- [—ﬁq
B N K S ~ X, X = =it =
Pegar @ = B K Af B E} T E Estilos | Edicién | Dictar Editor Reutilizar
- & A~ - A~ Aav A A D~ |29 v 32 archivos
Portapapeles = Fuente F Parrafo = fEstilos Voz Editor ' Reutilizar archivos |
L FOEIEER g belet s 200030t e a5 06 T 89 100 1Ly <120y 130y 140 o AESINEENESEEIY

.

v >

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas
porttitor congue massa. Fusce posuere, magna sed pulvinar
ultricies, purus lectus malesuada libero, sit amet commodo magna

p eros quis urna. Nunc viverra imperdiet enim. Fusce est. Vivamus a Interlineado

tellus.

Espaciado _{
- de parrafos

Nunc viverra imperdiet enim. Fusce est. Vivamus a tellus. Lorem ipsum dolor sit amet,
consectetuer adipiscing elit. Maecenas porttitor congue massa. Fusce posuere, magna sed

pulvinar ultricies, purus lectus malesuada libero, sit amet commodo magna eros quis urna.
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vilde Preuum matus, nunc. wviaurs qul neque lSGI’ﬁ venenaus
eienéria. Ut nonumity.

Aenean nec lorem. In porttitor. Donec laoreet
= Interlineado

nonummy augue. Pellentesque habitant morbi  doble
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tristique senectus et netus et malesuada fames ac




L4, Salts

» Pagina
» Columna

» Linia




4. Linies vidues i linies orfes

» Linia vidua

» Linia orfe

LINEA

dicbo cipacio de vicmpo, dercrminadas fucrzas opmi-
que rodcaban |2 Botidad Frimordial lc dcbaan dotarde
cicrea ioclinaciyo caracrcretica y guiarla co la clecdyo
de loy medios y del momeoto para cocaroanc.

Micotras taoto, los reflcjos de lay fucrzay clemcora-
ley supcriorcs afccando a la Eovidad Primordial traba-
jabao co ¢l muodo matcrial inclinando Pucrza Madre,
simbolizada por cl buitre y ¢l scllo, marcaba la Eotidad
Primordial coo los 1amboles.

Micotray taoto, la madrc bumaoa sc babea coower-
tido co ¢l ccotro gravitatorio dc fucrza clemcorala
quc formulaban un poder de awacciye ilwsorio co
toroo 4 yu perona, formulande o ol SAHU o Cucrpo
Astral del fururo scr bumaoe, jomaidoe 2 la magiade
lay fucrzay clemcotalay pamralcy. Dc onc modo, la
mujcr m6y imignificaorc sc vuclve atractiva por unp
ticmpo para su amaotc. Mo obiaotc, co cuaoto co-
cluye la cooperaciyo cotre lay Facreas del padre y de la
madre, ¢l SAHU ¢ adbicre répidamente al germen
vializado y pcrmaocee con Al co calidad de parryo
iovisible, 1ogo ol mal  la marcria aylida co graviea-
ciyn irf dando forma al acrpo marcrial. Eya opera-
ciyo del SAHU crplica la sisi cibida por alzuoos
d:n’uid:uta rc!pcgm al rcio uw::l:::;d: la \:rc unas(&r-
ma-plantae avociada a lay semillas,

Al conccorrarsc co wroo o yvulo vializade, ol Cacr-
po Elcmeowl deja 2 la madre bumana co su crade
oawral, despojada del atracieo ihuserio que lc babea
otorgado. Ella oo rcaspera o oo pucde rccuperar
poder capecial de sracciyo baa baber aumplido con
partc, redbifiodele del pucve sor bumano que cnb a
punto de criar.

HUE RFANA _‘ Eo cnc puato, #cmos que ol oico oo-pacido ¢ pre-

parado para cmcrger 4 la vida por loy padres. %

Cotribuyco mediante ¢l priocipio llamade por los
cgipcios HATI o «corazyo corcros. Eno ¢, cl Ceotro
de loy instioros berodad oy, raciales ciodividuale, y que
incluyco fuociones como ladigeniyo, cl oado, la vina,
cl olfaro, crc Eo upa palabra, cl HATI o1 lo arfeico y
ticoc revcnido por uo acrpo formulado por las facr-
ty clemeorales, o SAHU. Aoty y despuity de la wo-
cepeiyo, ¢l SAHU o cucrpo anral poscc aic poder de
radiaciyo, que formy la crfcra de arracdyo co roroo a
la madrc bumaoa, que fuc scllado por la Grao Fucrza-
Madrc-Buitre co o momeoto de I;coocn:pd{: ¥ que 1c
ba rctirade iomaotfocamcorc para formar la ofcra o
aura del futuro ser bumano, KHAIBT o aura radiaotc.

Eo ¢l momcoro del pacimicor, o Ege 3c uoc al
cucrpo. Existco muchay reproscowcioney, que daran
del peraodo de  civilizaciyo ?ipr.ia mbs clerada y
mucnran o oacimicoto de granda praocipes, y co las
que ¢ puoden reconocer lay dobley Formay, r.cratial ¥
wrreoal, de geocradyo de cucrpos. Dicho de otra
forma, ¢l HAMMEMITda vuchas yarroja cotonccs uoa
cmapaciyo llamada KA o doble del recifio pacide, y
firta 3¢ uoc al cucrpo tcrrcoal.

Loy tcatos qgipcios sicmpre mencionan al HATI co
asodaciyo coo ¢l AB o Corazyo. Del mismo mode que
cuando convcriamon, a mcoude coofuodimos y combi-
oamoy ionioto oo voluotad. La voluotsd o uoa cuali-
dad latcotc co ¢l aoimal, Eo ¢l bombre, pucde serdesa-
rrollada y culivada basea converriric co Voluowud Libre.
Asimiyme, ¢l AB (roluouad) o Mavc Rojs del Corazyo
quoda reprascotade co cl Lo & by marior por uo
rcccg:allo quc cooticoc un bucvo y uo germeo cyoea-
vo. Cusode dicho germen opocavo scdesarrolla porque
sc culiva, la serdadera sida y cf woral dasarrollo del Ego




L4, Llistes

» Numerades.
» Pics

» Multinivell

NdUol

o]l *]s

@ Cambiar nivel de lista

Definir nueva viieta...




C4. Nameros i pics personalitzats

» Elements personalitzables
» Opcions disponibles:

» Taules, Consultes, Formularis, Informes

© Elements de la base de dades

&
** Taules

A
*+* Consultes

&
*s* Formularis
.

*s* Informes



Ch TRAETAT[]'E' A NFORBORSCRTA
FORMAT DE LA PAGINA



G4. Format de pagina

» Columna
» Marges

» Orientacio




4. Columnes

» Quantitat, amplada, separacion
» Regla horitzontal
» Limits de les columnas
» Us comu:
» Articles periodistics

» triptics

] Disefio de pagina '

5

i Orientacian Tamano

- -

Configura

Referencias Corresp

Columnas

b= Saltos =
4= .
glﬂ Mumeros de

b~ Guiones ~

Mas columnas...

LIna

Cras

Tres %

[zquierda

Derecha




G4. Marges

No hi ha minim
4 per full
Determinar I'amplada

Pagines oposades i

vV v v v VvV

Marges addicionals




4. Orientacio

» Vertical

» Horitzontal
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Section 1

i = | section 2

4. TRACTAMENT DE LA INFORMACIE ESCRITA
SEGLIUNS




4. Seccions

» Format de pagina
» Columnes

» Marges

» Orientacio

» Capcaleres i peus
» Numeros de pagina




C4. Crear seccions

» Seccid continua

» Seccid a pagina seguent




C4. LES SECCIONS CONTINUES
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C4. Salt de seccid a pagina seqiient

» Inici en una nova pagina
» Apartats diferenciats

» Canvi d’orientacio
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[4. Encapgalament/peu de pagina i numeracid

» Encapcalamenti peu de pagina
» Numero de pagina
» Primera pagina diferent

» Diferenciacio entre seccions




C4. Capcaleres i peus a diferents seccions

» Personalitzacio de cada seccion

» Pas a pas:
> 1. Crear seccions amb salts de pagina.
> 2. Fer doble clic a la capcalera.
> 3. Desactivar "Vincular a I'anterior”.
> 4, Afegir el contingut personalitzat.

» 5. Repetir per cada seccid.




C4. Referencies creuades

» Vincular o enllagar elements dins del mateix
document.

» Ajuda a:

» Mantenir referencies automatiques a seccions,
figures o taules.

» Facilitar la navegacio en documents llargs.

06-referencias-cruzadas - Word al = O

Archivo Inicio QENCIM Disefic  Formato  Referencias  Correspondencia  Revisar  Vista W Indicar.. Kayl.. S Compartir

[ P
== D= L il 4|
3 L 8 = [e]] 5
Péginas| Tabla Imégenes Imagenes Formas Aplicaciones| Video Vinculos| Comentario Encabezadoy | Texto |Simbolos
- - en linea BT 4 en linea - .pie de pagina~| - -

|I|)

Tablas st Referencia cruzada ? x
Entorno A
Tipo: Referencia a:

En Iz actualid — — -
Elemento numerado v |Textc- del marcador Izl

“ b ulo e 2 Incluir mas adelante o mas atras p

: Titulo |

Win Marcadar Lo,
Mota al pie

Los ordenade |y ot alfinal ..

cada vez mas |Eguation .

Hardware

<oft z. |Instalacion s
Software

que s ill al

incluyen cues mao |:|

correo electn ES

Bon Voyage t ble
en 3 de las ez be
accedera el ¢ Insertar | | Cancelar

gente.

Necesidades Empresariales

El personal de Excursiones Bon Yoyage ha identificado los siguientes "deseos y necesidades” en sus

operaciones actuales:




G4. Tipus de referéncies creuades

» Elements que es poden referenciar:

>

vV v v VY

Element numerat

Encapcalament - Enllag a apartats del document
Marcador - Referencies a seccions especifiques
Notes a peu de pagina o final

Equacions, il-lustracions i taules

» Referencia segons tipus:

>

>

>

Numero de pagina.
Numero d’element.

Numero de paragraf.




C4. Inserir referencia creuada

Pas a pas: —
) . I.. H o de phging  Aefererias
1. Crear I'element que es vol referenciar. i o S it
s e L S
. . . plmi W o Sebrdn = S5 LEra Caginal .
2. Situar el cursor on es vol inserir. T Kot

.

1 4 J ¥ L

3. Seleccionar "Insereix referencia". | [NOMBRE-DEL-ALUMNO:x | Ausencic -
[NOMERODELSTA® |70 |
. . \ . | | GRUPD: A
4. Triar el tipus de referenciaila 1 & : .
informacioé a mostrar. |
| | INDICEY
: . . 1
5. Es pot configurar com a hipervincle 1
e e - 7/ s “
er facilitar la navegacio. 1 | _ _ _
p g ] | S e phore L FIGURA 3
Figina] Ge® | Faisbrer 1,838 (D Eapadiol Erpafa infenacional | ] -




o6, TRACTANENT D LA INFORMACID ESCRITA
CORRECTOR. ORTOGRAFIC



C4. Corrector ortografic

Revisa tot el document
Diferents idiomes
Comparacio de paraules

Afegir paraules al diccionari

vV v v v VvV

Corregeix paraules repetides




4. Diccionari

Afegir o editar paraules en el corrector ortografic:

1. Obrir les opcions de revisio.
1. A Office: Fitxer > Opcions > Revisio.

2. A Outlook: Fitxer > Opcions > Correu > Ortografia i
Autocorreccio > Revisio.

2. Desactivar l'opcid "Suggerir només del diccionari
principal" per veure més suggeriments.

3. Seleccionar diccionaris personalitzats i afegir noves
paraules.




E4 FRACTAMENT O LA INFORWAIO ESCRITA
" COMBINACID DE CORREU



4. Combinacit de correu

» Processament automatic

» Util per a cartes, correus massius o etiquetes
personalitzades.




U4. Elements essencials

» Origen de dades

» Document principal 4] A 2 | <
1| Nombre Apellido Direccion
2 [Matalia Ferrlandez Calle
3 |Pedro Arrrio Call/Mayor 765
E .
=
= Natalia Fernandez
g Calle Real 1232
9
10

Querida Natalia:




C4. Document inicial

» Base de tots els documents

» Camps variables




L4. Llista de destinataris

» Full de calcul
» Taula o consulta

» Llista de correu electronic




G4. Camps de combinacid

» Categoria de dades

1D Alias Apellidos Direccion  Codigo Pos
1 Africa AROCAS PA PADRO , 10508028
2 Agata VISO GILAE CASA CORDEDS8029

DOCTOR FLE'08030
BERTRAND | ‘08031

3 Aguador AYALA FE
4 Albatros BAEZ TEJAD

5 Albert BASTARDES CARRIO , 12, 08032
& Alien AMNGUERA VI PIRINEUS , 108033
7 amores PASCUAL A ACINT VERD 08034
8 Anabel VALLES GIR! NOU , 9, 2N. /08035

ACINT VERD 08036
OAN MIRO ., 08037
AUME GALOD8038

9 Antiga RAYA GARCI
10 ballador ANDREU CR
11 balladora BARALDES

12 Barbilla BERENGUE PINTOR SERT 08039
13 Besugo LOPEZ DE P BELLAVISTA 08040
14 Banart ARNAL MNR MORNTT IRICE Nena T




(4. Registre

» Conjunt de camps

» Individu o objecte

ID Alias Apellidos Nombre Direccion  Codigo
1 Africa AROCAS PASESTEFANIA PADRO, 10908028
2 AiEItEI VISO GILABE QUERALT CASA CORDED8029
4 Albatros BAEZ TEJADC]OAN BEERTRAND | 08031
5 Albert BASTARDES MARC CARRIO , 12,708032
& Alien ANGUERA VI JOSEP PIRINEUS , 108033
F amores PASCUAL ALESTHER JACINT VERD 08034
8 Anabel WVALLES GIRv LAURA NOU , 9, 2N.'08035
9 Antiga RAYA GARCIERAQUEL JACINT UEHD.:HEHEE




G4. Camp combinat

» Situat on han d’apareixer les dades
» Indicat entre cometes angulars: <>

» Substituit automaticament per les dades corresponents
en cada registre.

«Nom bre:r:-‘

Enla ficha Insertar, las gale
generaldel documento. Pu
pagina, listas, portadas y «

organigramas o diagramas




4. Bloc d'adreces

» Conjunt d’informacio d’un destinatari

» S'utilitza en la combinacio de correu per inserir
automaticament les dades dels destinataris.

ESTEFANIA AROCAS PASADAS

PADRO, 109
«Bloque de direccion» Zaragozal
En la ficha Insertar, las galerias incluyen eleme Enla ficha Insertar, las galerias incluyen elem:
generaldel documento. Puede utilizar estas gz general del documento. Puede utilizarestas g
pagina, listas, portadas y otros bloques de ¢ pagina, listas, portadas y otros bloques de «
organigramas o diagramas, también se coord organigramas o diagramas, también se coor

Puede cambiar facilmente el formato del tex

apariencia para el texto seleccionado desde




(4. Combinacia de correspondencia

1. Establiri Triar un Tipus de Document
2. Triar el document

3. Seleccionar els destinataris

4.  Escriure el document

5. Comprovar el resultat

6. Finalitzar




4. Resultats de |a combinacid de correu

» Impressora
» Email

» Documents pdf




4. TRACTAMENT DE LA INFORMACIG ESCRITA
PLANTILLES



L4, Plantilles

Creacio de plantilles

» Crear un document nou
» Definir els estils
» Fer els canvis de seccio, si escau
» Determinar els sagnats i espais entre linies i paraules
» Introduir el text fixe
» Introduir el text o els espais indicats per al contingut
variable

» Desar com a plantilla




i)
S

e B

4. TRACTAMENT DF LA INF,I]RMAEIIj ESCRITA
PSS NSERCIO D'ELEMENTS

=



C4. Insercid d'imatges

Podem fer-ho:
» A través del menu Insereix.... Imatge

» Arrossegant la icona del fitxer cap al document




C4. Posicid de la imatge

» Superior

» Esquerra

HEEREE Sl -"J-I._I.-I'Is

FE EFE

p Centre

p Dreta

> Mig
» Esquerra

p» Centre — B _

p Dreta

» Inferior =2 : —

» Esquerra

p Centre

p Dreta




G4. Ajustament de text

En linia
Quadrat
Estret
Darrere text
Davant text

A sobre i a sota

vV v v v v Vv

e

In Line with Text

Square

Tight

Behind Text

In Front of Text

Top and Bottom
Through

E.-:Il;. |:| Foints

Maore Layout Options...




L4, En linia

» Com a caracter
» Lletra capital

» Icona/emoticona

On the Insert tab, che galleries include items that are designed to coordinate with the
overall look of your document. You can use these galleries to insert tables, headers, footers,
lists, cover pages, and other document building blocks. When you create pictures, charts, or
diagrams, they also coordinate with your current document lock. You can easily change the
formatting of selected text in the document text by choosing a look for the selected text from
the Quick Styles gallery on the Home tab. You can also format text directly by using the other
controls on the Home tah.l




4. Juadrat

» Qualsevol posicio
» Text interromput

» Abans i després

On the Insert tab, the
coordinate with the
galleries to insert tables,

document building blocks.

"
-
]
-
.

X

galleries include items that are designed to
overall look of your document. You can use these
headers, footers, lists, cover pages, and other

When you create pictures, charts, or diagrams, they

also coordinate with your current document look. You can easily change the formatting of
selected text in the document text by choosing a look for the selected text from the Quick
Styles gallery on the Home tab. You can also format text directly by using the other controls on

the Home tah.l




L4, Estret

» Al voltant de la imatge

» Seguint-ne el contorn

On the Insert tab, the galleries include items that are designed to coordinate
with the overall look of
tables, headers, footers,

yvour document. You can use these galleries to insert
lists, cover pages, and other document building
blocks. When vyou create pictures, charts, or diagrams, they also coordinate
with your current document look. You can easily change the formatting of selected text in the
document text by choosing a look for the selected text from the Quick Styles gallery on the

Home tab. You can also format text directly by using the other controls on the Home tab.




G4. Darrera del text

» Text sobre la imatge

On the Insert tab, the galleries include items that are designed to coordinate with the overall

look of your document. You ca T-Usegthese galleries to insert tables, headers, footers, lists,

olocks. When you create pictures, charts, or
diagrams, they also coordinate- irrent document look. You can easily change the
text by choosing a look for the selected text from
the Quick Styles gallery on the Home tab®¥ou can also format text directly by using the other

controls on the Home tab.




C4. A sobre i a sota

» Text a sobreiasota

On the Insert tab, the galleries include items that are designed to coordinate with the overall
look of your document. You can use these galleries to insert tables, headers, footers, lists,
cover pages, and other document building blocks. When you create pictures, charts, or

diagrams, they also coordinate with your current document look. You can easily change the
formatting of selected text in the document text by choosing a look for the selected text from
the Quick Styles gallery on the Home tab. You can also format text directly by using the other
controls on the Home tab.




4. Davant del text

» Text sobre la imatge

diagrams, they also coordinate-fi . srrent document look. You can easily change the
text by choosing a look for the selected text from

the Quick Styles gallery on the Home tabifou can also format text directly by using the other

controls on the Home tab.




C4. Comprimir imatges

» Seleccionar la imatge

» Opcié Comprimir Imatge
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Ga. TRACTAMENT INFI]RMAEIIJ ERAFIEA SUNORA | DE LA IMATBE EN MOVIMENT

DADES PERSONALS



(o. Dada personal

» Persones fisiques
» Identificades

» Identificables

» Unaimatge




[o. Fotograties

RECONEIXEMENT = CONSENTIMENT




[o. No requereix permis

No es reconeix
Fins culturals,
Cientifics i

Historics

vV v v v VvV

Fets rellevants




Co. No intromissid il-legitima

» Carrec public
» Professio de projeccio publica

» Acte public o llocs oberts al public




RESOLUTION

PIXELS

—1920 x1080 —

L F o .

5 TRACTAMENT IFORMAI GRAFICA, SONORA | OE LA INATGE EN MOVINENT
FORMATS DE LES IMATLES



Co. Edicia d'imatges (retoc de fotografies)

» Modificar imatges

» No crear-ne




[o. Resolucia d'imatges

» Qualitat d’'una imatge digital

» Imatges de baixa resolucid




Co. Pixels i megapixels

» Pixel

» Unitat minima de color
» Megapixels

» Un milid de pixels




Ca. Resolucid alta o baixa

» Alta resolucio

» Baixa resolucio




[o. Resolucia pantalla

» Mesurada en pixels

» Meés resolucio = més detall

1280 x 720
—— 1366 x 768

1440 x 900

1600 x 200
—— 1680 x 1050
TT-1920 x 1080

1820 x 1200

- 2560 x 1440

T 2560 % 1600




[o. Format de pantalla

» Pixels horitzontals i verticals
» Meés pixels = més resolucio

» Més resolucio = més potencia




[a. Polzades

» Una polzada equival a 2,54 centimetres / 25,4 mm.

Tamano

{Diagnnal en pulgadas) Anchn Alio

75"

22 | 48.7ems. | 274cms. |
32" | 70.84cms. || 39.85 cms.
= 37" | sstems. | 4607cms. |

70" |
|
|
50" | 40" | 88.55ems. | 49.81cms,
|
,I
|
]
;I
;I

65"

60"

45!}

42" | 9298ems. | s2.3ems.

4"

37"

46" | 101.83cms. || 57.28cms,
50" | 110.69 cms.
52 | 115.12 oms,
60" | 132.83 cms,

32"

BZ.268 cms.
64.75 cms,

74,72 cms,
80.94 cms,

:|
|
|
|

5" | 143.9 cms.




[o. Extraccia d'imatges de la camera digital

1. Connectar a l'ordinador

» Cable
» TarjaSD
2. Obrir DCIM

3. Seleccionar imatges
4. Opcio tallar
5. Obrir carpeta

6. Enganxar-les




Co. Extraccia d'imatges del telefon mabil

1.  Connectar a l'ordinador
2. Donar permis

3. Obrir carpeta origen

4.  Tallar

5.  Obrir carpeta desti

6. Enganxar




Co. Targeta oD

» Memoria externa

» Emmagatzematge ampliable




Co. Copiar, tallar i enganxar

» Tallar i enganxar
» Moure a...

» Copiarienganxar




.|

Resolution 100%

Proportions

[ ~————— — —

Pixelation

5. TRACTAMENT INFORMACIC GRAFICA, SONORA | OE LA IMATGE EN MOVINENT
IMATGE



Co. Tipus d'imatges

» Mapa de bits

» Imatges vectorials




[o. Compressio

» Sense perdua

» Amb perdua




Co. Formats d'imatge

» Amb perdua
» JPEG

» WEBP

» Sense perdua
» BMP
» TIFF
» GIF

» PNG




La. BMF

» Escassa compressio
» Sense perdua

» Imatges de 24 bits




La. JPEG

Compressio amb perdua
Grau de compressio flexible

Imatges de 24 bits

vV v v VvV

Serveix per mostrar o transmetre imatges en color
real per Internet.

» No serveix per a conservacio d’imatges originals.




La. TIFF

Pot comprimir-se o no
Compressio sense perdua

48 bits

Format multipagina

vV v v v VvV

Ideal per a documents que seran impresos




La. GIF

Compressio sense perdua

8 bits

256 colors

Permet animacions i transparencies
S'utilitza per:

Pagines web

Imatges amb colors solids

vV v v v v v v Y%

No apte per fotografies d’imatge real




La. PN

» Alta compressio sense perdua
» Accepta transparencies

» Profunditat de color molt gran




La. WEBP

» Google
» Pesinferior al JPEG i al PNG
» Compressid amb i sense perdua

» Transparencies i animacions




. Vectors: SV

» Format vectorial
» Alta qualitat

» Escalable

» Lleuger

» Estandard




La. Imatges de GO (IS0)

» Copiad’'un CD o DVD

» No imatge digital
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C5. TRACTAMENT INFORMACIC) GRAFICA, SONORA | DE LA IMATGE EN MOVIMENT
EDICIO D'IMATGES



Co. Editors d'imatge

Qualsevol format d’imatge
Fotomuntatges
No creen de cero

Capes

vV v v v VvV

Exportacio a diferents formats




[o. Fotomuntatges




[o. Capes

» Permeten modificar cada part sense afectar la resta.
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[a. Editors de so

» Gravar
» Tallar, enganxar
» Convertir format d’audio

» Modificar el volum




(. Edicia de so

» Millora de la qualitat del so
» Soroll
» Equalitzador

» Compressio




[a. Formats de so

» Sense compressio
> WAV
» AIFF
» CDA
» AU

» Compressido amb perdua
» FLAC
» MP3
» MPEG-4

» Compressio sense perdua
» Vorbis
» AAC
» WMA




-.‘__}-

' EE TRAETAMENT INFURMAEID ERAFIEA Sl]N[IRA | []E LA IMATBE EN MOVIMENT
EDICIC DE VIDED




[a. Editors de video

Tallar i enganxar
Afegir imatges i musica
Unir videos

Modificar qualitat

Importar i exportar a diferents formats

vV v v v v Vv

Afegir efectes de transicio, subtitols, etc.




Go. Orientacid a I'hora de gravar un video

» Orientacio horitzontal: Professional

» Orientacio vertical: Xarxes socials




[a. Fitxers de video

vV v v v v v v Y%

MP4
MOV

WMV

AV

AVCHD

FLV, F4V y SWF
MKV

WEBM o HTML5




La. MP4

» Molt extés
» Compatible

» Comprensio amb perdua




La. MOV

» Apple
» Alta qualitat
» Edicio de video professional

» Compressido amb perdua




La. AV]

vV v v v v Vv

Microsoft

No per compartir

No per streaming

Fitxers de mida molt gran

Perdua qualitat amb la compressid

No emmagatzema subtitols




La. WMV

» Successor de I'AVI
» Poc acceptat pels reproductors

» Compressido amb perdua




La. WEEM

» Codiobert
» Desenvolupat per Google

» Requereix html




Ga. Millor per...

» Videos en linia
> MP4
» WEBM
» Videos familiars
» MP4
> AVI
» Aplicacions Windows

» WMV

» Youtube
» MP4

» Instagram

» MP4
» MOV




[a. Streaming

» Reproduir sense descarregar
» Radioividio online
» Accedir al contingut en directe

» Aturaritornar a comengar




La. Suport digital i FTP

» Transferéencia de fitxers

» Model client-servidor




La. Suport digital i FTP

» Utilitzat per gestio de webs, copies de seguretat
i transferencies de grans arxius.

File

FTP
Server




R TRAETAMENT i: LA INFORMACI NUMERICA
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CB. TRACTAMENT DE LA INFORMACIG NUMERICA
BRAFILUES

288



Cb. Tipus de grafiques

Xarxa
Area
Linies
Circular

Columnes

vV v v v v Vv

Barres




Gh. Grafics de columna.

» Aquest tipus de grafic fa especial emfasi en les
variacions de les dades a través del temps.

» Les categories de dades apareixeran a |'eix
horitzontal i els valors a |'eix vertical.

T 1 T Fimd Fin




Lh. Grafics de linia.

>

Un grafic de linia mostra les relacions dels canvis a
les dades en un periode de temps.

Aquest grafic és comparat amb els grafics d’area,
pero els grafics de linia fan un emfasi especial en les
tendencies de les dades més que en les quantitats
de canvi com ho fan els grafics d’area.




Cb. Grafics circulars.

» També coneguts com a grafics de peu (en angles) o
grafics de pastis.

» Aquests grafics poden contenir una sola serie de
dades ja que mostren els percentatges de
cadascuna de les parts respecte del total.

Tipo de pelicula favorito

Ciencia ficcion: 4 (20%}

Comedia: 4 (20%}

Drama: 1 (5%}

Accion: 5 (25%}

Romance: 6 (30%}




L. Graficos de Barra

» Un grafico de barra hace un énfasis en la
comparacion entre elementos en un periodo de
tiempo especifico.

» Este tipo de grafico incluye cilindros, conos'y
piramides.

0 100 200 300 400 500 600 70O




CE. Graficos de Area.

» Los graficos de area muestran la importancia de los
valores a través del tiempo.

» Un grafico de area es similar a un grafico de linea,
pero ya que el area entre las lineas esta relleno, el
grafico de area le da una mayor importancia a la
magnitud de los valores que lo que puede hacer un
grafico de linea.




Cb. Gratics XY (Dispersid)

» Els grafics de dispersio son utils per mostrar la
relacio entre diferents punts de dades.

» Aquest tipus de grafic utilitza valors numerics per a
tots dos eixos en lloc de fer servir categories en
algun dels eixos com en els grafics anteriors.




Cb. |dentiticacia d'elements d'un grafic

Area del grafico

Titulo del grafico

Area de trazado

Lineas de la cuadricula

Monta

56,000.00
55,000.00
54,000.00
53,000.00
52,000.00
51,000.00

50.00

Ingresos

54,519.00) 54.878.00

54,605.00

54,157.00
§3,800.00

$3,377.00

S———
m Ingresos

T

Titulos de ejes [l Serie de datos

EXCELTOTAL.COM

Leyenda




L. Treball entre dos llibres

>

>
>
>
>

Moure o copiar L'ordre pot ajudar-lo a inserir fulls de treball d'un altre llibre
facilment.

Pas 1: Obriu tots els llibres de treball amb que treballareu.
Pas 2: Activeu el llibre de treball que conté el full de treball que copiara.
Pas 3: seleccioneu els fulls de treball que voleu copiar.

Pas 4: feu clic amb el botdé dret al full de treball seleccionat i feu clic a Mou o copiar
del menu de contingut.

Pas 5: a Moure o copiar quadre de dialeg, seleccioneu el llibre de treball al qual
copiara els fulls de treball seleccionats a la llista desplegable Moure fulls seleccionats
de Al llibre:, i revisa el Crea una copia .

Pas 6: Click OK. Després, veureu que els fulls de treball seleccionats es copien i
insereixen al llibre de treball que va especificar al Pas 5.



LB. Filtres i ordenar

DeAal’Z

Ascendente

DeZaA

Descendente

—

M

COrdenar| Buscary

% l. COrdenarde Aa Z

¥ v
- y filtrar =| seleccionar -
il Ordenarde £Za A
M

@ Orden personalizado...
W= Filtro
& | Borrar

{;r Yolver a aplicar




LB. Funcions

Tipus de funcions del full de calcul Excel

>

>
>
>
>

Funcions Matematiques i trigonometriques.
=SUMA(A3:A6)

Funcions de text. =CONCATENAR(“Google “;B7)
Funcions de data i hora. =HOY()
Funcions Estadistiques. =MAX(A1:A60)

Funcions de cerca i referencia.
=BUSCARV(A13;5CS2:5DS9;2;0)

Funcions Logiques. =SI(A6>A7;VERDADERO;FALSO)
Funcions Financeres.

Funcions de base de dades.




LB. Funcions

El signo dos punto

Los paréntesis separa el fin y el
encierran los comienzo de un
argumentos rango de celdas. =SUM( 83'812)
e
_ \- Bf“i““ . T T
-Suma(ﬂ?m 5-510.':’*’0;33] Signo igual Argument

I \/ Nombre de la funcién
Nombre de la

funcién El signo punto y
coma separa los
argumentos de una
funcion




Lh. Estil de cella

» Com crear i modificar Estils de cel-la:

v

Seleccionar la cel-la que té el format que es vol
utilitzar per al nou estil.

Feu clic al boto Estils de cel-la a la pestanya Inici.
Seleccioneu Nou estil de cel-la.

Introduir un nom al camp Nom de I'estil.

vV v v VvV

Feu clic a D'acord.




<% TRAETAMENT DE LES []ADES



DADES
GUONCEPTES




(7. Base de dades (concepte)

» Conjunt dades

» Ordenades E _;-:__g.:-;-;,

- Tie. 10

» Connectades




(7. Fases del disseny d'una base de dades relacional

» Disseny conceptual
» Disseny Logic

» Disseny Fisic




G7. Tipus de dades per a cada camp

Numeric

Alfanumeric (text curt)
Text llarg (memo)

Data i hora

Moneda

vV v v v v Vv

Boolea




7. TRACTAMENT DE LES DADES
FLEMENTS




7. Elements d'una base de dades

» Taules
» Consultes
» Formularis

» Informes




7. Taules

» Facil d'importar
» Organitzacié
» Evitar redundancies

» Normalitzacio




(7. Camps i registres

» Camp = tipus de dada

» Registre = conjunt de dades




7. Consultes

» Recuperar dades

» Filtrar dades




7. Formularis

Interficie amigable
Diferents tasques
No obligatoris

Introduir, modificar, eliminar dades

vV v v v VvV

Restriccions




7. Informes

» Donar format
» Presentar resultats especifics

» Imprimir




7, TRACTAMENT DE LES DADES
RELAGIONS



7. Relacia taules

"F. - = :I Mprh s
":":'I-!:':Is | Ii- I':P':':"'.I-'.'
ST T R = IaCipnte
| MamfrePuodics ' :
ek is Celabey de peedales TrEmpienzn
stk o T e FectaFedida
CarBcwd P e b ,ﬂ.,,ml
:'r-l:-:l-:lIJrlﬂi-l:l Predolinkisg 4 rr.-|-:|
Ui ErER A e E'mm
sarna o ErPed g Sy et
faH i Pl I Carercabe [edkinstanip
Sarpenediin - Cudadhetingtuia
| tan Rrg=nomlinalarks
Codroiaile ks nabari=-
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(7. Prequntes

v

vV v v V¥

Dades privades i bases de dades?
Consultes de consultes?

Les consultes permeten modificar les dades de les
taules?

Informe a partir d’un formulari?
Informe a partir d’una consulta?
Pases per crear formularis mitjancant I'assistent

Ordenacio de les dades d’un informe




Ld. PRESENTAGID DE GONTINGUTS.
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o8, PRESENTACIC DE CONTINGUTS,
MODES DE VISTA



8. 4 modes de vista + |

Vista Esquema
Vista Notes
Classificador de diapositives

Vista Normal

vV v v v VvV

Vista de presentacio




Ca. Vista Esquema

» Nomeés admet el text de la diapositiva
» (el que es veura per pantalla)

» Creem l'estructura de la nostra presentacio




8. Notes

Son nomeés per l'orador

'orador les veu (a la seva consola)
Textos lligats a la diapositiva

Les introduim per ordre de paragraf

Tenen format

vV v v v v Vv

Només admet text




(8. Classificador de diapositives

» Permet una vista general de la pressentacio

» Podem modificar l'estructura (movent les
diapositives de lloc)

» No podem introduir res
» Només permet:

» Eliminar

» Duplicar

» Moure

» Amagar




L. Vista Normal

» Tot el que es pot fer a la resta de vistes
» Permet inserir imatges, grafiques...

» Pensat per treballar sobre la diapositiva




C8. Vista presentacio

» Per veure com esta quedant




Slide Design

o Use a consistent theme

08 PRESENTACII D I][IN%INELITS
FURMAT [ DISSENY Dt DIAPOSITIVA



[8. Format o disseny de diapositiva

» Quantitat d’'objectes/elements de la diapositiva

» La seva distribucio
» Ajuda a donar format

» El podem canviar sense perdre el contingut

| Tema de Office
N\ rrm——
e S N I
" Diapositiva de Titulo y objetos Encabezado de
3 titulo seccion
iz
0 '
E - -
N Dos objetos Comparacion Sélo el titulo
i
| -"‘"""'\::’"""""""": ' ...................
n - i
- $ =
e -
KRR |
SRS - SR BT
En blanco Contenido con Imagen con titulo
titulo
7] Duplicar diapositivas seleccionadas
;_ Z%] Diapositivas del esquema...
<
‘=] Volver a utilizar diapositivas...

quedando




[8. Format o disseny de diapositiva

A destacar:
» Titol i subtitol
» Objecte
» Dos objectes

» Buida

i Disefio q

catibritCuernm = l2a -l A% (@] ja=

Tema de Office

.............................

Diapositiva de
titulo

Titulo y objetos

Encabezado de
seccion

T Tl
S [ et |

T "
RS s

Dos objetos

Comparacian

56lo el titulo

En blanco

Contenido con
titulo

Imagen con titulo

e

-




[8. Format o disseny de diapositiva

» Primera diapositiva titol
» Segona per defecte objecte

» Siinserim una diferent, les segients que inserim
per defecte seran iguals a aquesta

» Podem canviar el formar sense perdre el contingut




8 PRESENTAEIUDE CONTINGUTS
PATRI]NS



8. Patrons

Diapositiva mestra: Patrd de notes

» Font (tipus de lletra) » Tenen format

» Tema (colors) » Elements d’impressid

» Elements comuns

» Elements de la impressio

> PROHIBIT ESCRIURE ;gg:;gfpgj;gnmﬂdiﬂcafe'est"ﬂde

Segundo nivel

L, L

» Podem fer servir més d’un it

Quinto nivel
» Han de ser homogenis




(8. Patrd de notes

» Encapc¢alament
» Peu
» Data

» Numero pagina

Encabezado 24/01/2024

Haga clic para modificar el estilo de
titulo del patrén
* Haga clic para modificar el estilo de texto del
patrén
= Segundo nivel
= Tercer nivel

Lt ceod

* Queriu rend

Haga ciic para modilicar o estilo de texto del patrén

Segundo nivel
Tercer nivel
Cuarto nivel
Quinto nivel

Pie de pagina




8. Notes

» Només es poden imprimir a una diapositiva per
pagina

hgftufuj

= Ffaga
= afafa
= asfsag

The quick brown o jumps war the baydog, The quick b o jumps aver the
Lazy dhog. The:quikck rcrn Jou Umis aner the Loy dog. The: quick brown 3 jumps
ower the ey dog.

The quick brown o jumps war the baydog, The quick b o jumps aver the
Lazy dhog. The:quikck rcrn Jou Umis aner the Loy dog. The: quick brown 3 jumps
ower the ey dog.

The quick brown o jumps war the baydog, The quick b o jumps aver the
Lazy dhog. The:quikck rcrn Jou Umis aner the Loy dog. The: quick brown 3 jumps
ower the ey dog.




C&. Per preparar |a presentacia podem

» Imprimir les notes » Imprimir presentacio amb
espai per a notes

- ——
hgftufuj 1
——
- Ffaga
- afafa
= asfzag
——
E
——
:3
The quid brown oo pums over e bay dog. The quic beon fox jumpes oner the
Lazy dag. The quick brown fo umps over the Lzy dag. The quick brown o umps
aver the laydag.

The quick brown fou jumgs over The by dog. The quid eown fon jumps awer The
Lazy dag. The quick brown fo umps over the Lzy dag. The quick brown o umps
awer the ey dog.
The quick brown fou jumgs over The by dog. The quid eown fon jumps awer The
Lazy dag. The quick brown fo umps over the Lzy dag. The quick brown o umps
awer the ey dog.

) No son les notes,
son espais per
anotar a ma




(8. Disseny o plantilla de presentacio

» Afegeix un patro predefinit
» Amb els temas (colors)

» Eltriem d’una galeria d’estils

Aa rv— - Aa
_ e L L I T R

e




G8. Que definim a la plantilla

» Tipografia
» Temes

» Elements comuns

» Elements impresio




(8. Podem definir més d'un patrd per presentacian?

Si
» Pero han de ser més o menys homogenies

» Podem aplicar patrons diferents a diferents
diapositives




IiS. ;RESENTAE\['I DE E[INT\NELITS.
TRANSICIONS | ANIMACIONS



8. Transicions

» Pas d’una diapositiva a una altra
» Botd aplicar a totes
» Poden tenir so
» Millor format WAV
» Velocitat, efectes i com executar-les
» En fer clic
» Amb temps (automaticament)
» Les dues anteriors

» Fent servir un botd d’accid




8. Transicions

>
>
>
>
>

>

Efecte per a tota la diapositiva
No ha de ser igual a totes

Pero és recomanable

Per un orador és millor en fer clic

Per enviar per correu a un client en automatic (amb
temps)

Podem afegir-ne so
No és la millor opcié com a so de fons

Existeix una opcid per “aplicar a totes”




8. Sobre |as Transicions

» Admeten so

» No és l'opcid més adient per a la musica de fons




8. Animacions

» Entrada
» Sortida
» Enfasi

» Trajectoria




(8. Exemples d'animacid




C8. Animacions de text

» Paraula per paraula
» Lletra per lletra
» Ordre invers

» Com un objete




(8. Cronometratge d'animacio

En fer clic

Després de |'anterior
Amb l'anterior
Retrassar x temps

Rebobinar

vV v v v v Vv

Repetir




[8. Etectes

» Difuminar
» Ampliar

» Canviar de color
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C8. Presentacid personalitzada

» Crear/Configurar diferents presentacions
» A partir de la mateixa presentacio

» Serveixen per adaptar la nostra presentacio a
diferents publics

» No diferents fitxers
» Un unic fitxer amb diferents diapositives

» Estracta d’'una manera més eficient d'amagar
diapositives

No es poden editar per separat




[8. Passes a sequir

» Menu presentacions, opcio presentacio
personalitzada

Nova
Posar nom i triar les diapositives

Acceptar

vV v v VvV

Mostrar
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8. Taules

» Format predefinit
» Galeria d’estils
» Casella de configuracio

» Temes

Nom

Telefon

Web
www.b1b2b3.org

Email
info@b1b2b3.org



http://www.b1b2b3.org/
mailto:info@b1b2b3.org

(8. Les taules...

>

Es poden modificar sobre la marxa (num. files,
columnes, colors...)

No es poden girar
Columna 3

Poden tenir enllagcos Abc Def Ghi

'animacio és per a tota la taula Jkl Mnn opq

Abc Def Ghi

Jkl Mnn opq



Ct. Imatges

Herramientas de imagen

» Es poden retallar

o |

= pre-— gvem g
| el el sl F
Seleccione la flecha Recortar. “. e

Estilos de imagen H Recortar

[ PRecortaralaforma »

Relacion de aspecto #
i Relleno

Ajustar




8. Formes

» No son el mateix que les imatges

» No es poden retallar

-

P Q ul

Formas|SmartArt Grafico ' Hipervinculo Accion

Formas usadas recientemente 4

lBxeE~~OcOALL
DI 5 % N A

Lineas

e LM B R
Rectangulos




8. Combinacions

Ampliar o reduir sense perdre proporcions
Majus. (Shift) + arrossegar des d’una cantonada
Duplicar

Ctrl + arrossegar

Moure horitzontal o vertical

Majus. (Shift) + arrossegar

Duplicar en horitzontal o vertical

vV v v v v v v Y%

Ctrl + Majus. + arrossegar




8. Ordenar

» Portar al front

» Enviar al Fons

» Portar al davant

» Enviar darrere




8. Alinear

» Seleccionem totes les figures

» Aliniacio superior, al mig o inferior




L. Distribuir

» Selecciono totes les figures

» | l'opcio distribuir (horitzontal o vertical)

.




G&. Agrupar

» Es pot fer amb diversos objectes
» No és obligatori

» Modifica reaccio dels objectes




&

B

Carlos | Sergio
Marketling Sales Manager
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(8. Organigrama

» Mostra relacions funcionals

» Esquema organic d’'una entitat

» Les tres figures de I'exemple:
» Superior
» Assistent

» Subordinat




C&. Diagrama de proces

» Explicar alguna cosa que té un principi i un final

EN-EN-EB




(8. Diagrama de cicle

» Qualsevol procés de
millora en una empresa
és un cicle

O O
2 ¥

00




L. Circular

» Mostrar parts o proporcions
o distribucid que, juntes,
formen una unitat




(8. Blocs

» Diferents apartats que
es poden explicar per
c4 CS

c8




C8. Diagrama de Venn

» Relacions interconnectades

A < 4

Grup 3 Grup 2




C8. brafiques

» No giren

» Son un bloc

» L'animacio és per
a tota la grafica




8. Columnes

Evolucio Distribucio

6 100%
90%

2 80%
4 - 70%
60%

3 m Aigua 50%

5 ®Llum 40%
m Gas 30%

20%
10%
0%




[8. Inserir

Inserir:

» Suma pes a la presentacio 600000

» No actualitza 500000
400000 -

Vincular:

300000 - m Dones

® Homes

» No pesa més

200000 -
» S’actualitza

100000 -

» Elfitxer amb les dades d’origen
ha d’estar accessible 0.

.

Barcelona Girona Tarragona Lleida

Millor opcio per compartir per
mail, per Internet...




8. Sobre vincular

» Per compartir per correu és...
» Obligatori posar els fitxers

» A la mateixa carpeta




L. Linies

Columnes Linies
250 250
200 - 200
150 - 150
100 - = Dones 100

50 I ® Homes 50
0 - . . . [ 0
@}9&(-}\«0& ,bq,9°’b\>é>b’b

R < F




[d. o

» Inserir >>> So
» Millor opcid per a musica de Fons

» Apareix laicona de l'altaveu




(8. Videns

vV v v v v v 9%

Es pot reproduir
Automaticament

En fer clic

A través d’un botd

A pantalla completa

Clic a sobre per fer pausa

Els GIF animats NO son tractats
com a videos




8. Botons d'accid

» No son obligatoris

» Només séon formes amb
un suggeriment d’us

» Tots poden fer el mateix

> |

Video o Inici

i

Anterior Obrir
document




C8. Podem fer servir com a botd d'accid

Botons d’accio

Imatges

Formes TRO

Text

vV v v v VvV
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C8. Imprimir diapositives

» Triar impressora

o . . . Imprimir
» Triar diapositives o
_ o Nombre: /& Microsoft Print to POF
» Quantitat per pagina Estado:  Inactiva
Tipo: Microsoft Print To PDF
, . meon PORTPROMPT:
» Numero de copies e
Intervalo de impresién
© Todas (O Diapositiva actual Selecisn ~ Nmero de cop
O Presentadién personalizada: | Modos de vista
O Diapositivas; |

Escriba los nimeros e intervalos de diapositiva. Ejemplo: 1;3;5-12

!.Pég"nas de notas ~ ) | Diapositivas por pagina: [Z]
_CObr 0 escala de grises: _ | Criterio de ordenacion: €3 Horizontal Vertical
| Color v
‘ () Ajustar al tamafio del papel Imprimir diapositivas ocultas
(C) Enmarcar diapositivas () Alta calidad

Imprimir comentarios y formato de entrada manusaita

Vista previa Aceptar




G8. [mprimir notes

» Decidirem si hi ha d’apareixer:

» Data

» Encapcalament

» Peu

» Numero de pagina

» S’escriuen en aguest moment

r
Encabezado y pie de pagina

Diapositiva Notas y documentos para distribuir
kil en vk
B Fecha y hora
O Actualizar autométicamente
|25/01/2024 \
T

Idioma: Tipo de calendario:

|Espafiol (Espafia, internacional) . | |Occidental

OFija

|25/01/2024

(_)Encabezado

|

& Nimero de pagina
e e pigna

|

---------
...........

...........
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[8. Presentacid com a pagina web

» Fitxer .html

» No funcionaran les animacions ni transicions




8. Servidor FTF

» Necessari per poder pujar a la nostra presentacio a
la nostra pagina web

Per configurar-lo:

Domini (adreca de la nostra web)
Usuari i contrasenya

Protocol (FTP o FTPS)

Port

>
>
>
>
>
>

Presenta dues finestres, a 'esquerra els nostres
fitxers, a la dreta els de la web

Per pujar-los o descarregar-los només cal passar-los
d’un costat a l'altre




C8. Plantilla de continguts

» Diapositiva d’'exemple

» Contingut de la presentacio




C&. Consells a una presentacid

» Elmésimportant és el missatge

» La presentacido només és un suport
» Poc text
» Hadeserclar

» Facil de llegir

» Amb contrast




barcelonactiva.cat

Ajuntament de

A\ Barcelona
Barcelona (-‘

Activa




